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ABSTRAKT 

Bakalářská práce se skládá z několika částí. První z nich seznamuje čtenáře s programy pro 

virtualizaci operačních systémů. Další částí práce je manuál, který popisuje princip funkce 

programu VMware, včetně jeho modifikací. Dále obsahuje návod k použití VMware. 

Poslední část práce se týká přípravy diskových obrazů operačních systémů, používaných 

v předmětu Operační systémy pro program VMware. Systémy budou nakonfigurovány  

podle požadavků vedoucího práce. 

 

Klíčová slova: virtualizace, VMware, Microsoft Virtual PC, Microsoft Windows, Linux   

 

 

 

ABSTRACT 

This bachelor thesis contains several parts. The first one informs reader about programs for 

virtualisation of operating systems. The other part of  this thesis is manual that describes 

principle of function program VMware, inclusive of his modifications. Then it contains 

instruction of  using VMware. The last part of this thesis is concerning about making of disk 

images of operating systems used in subject Operating systems for program VMware. The 

systems will be configured under the requirements of  leader. 
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ÚVOD 

Pro výuku Operačních systémů potřebují studenti pracovat s právy administratora nebo 

roota. Protože není možné studentům povolit takový přístup na fyzické počítače ve 

studovně, je potřeba tento problém řešit pomocí virtualizace.  

Virtualizace je činnost, při které se na jednom fyzickém počítači emuluje jeden nebo více 

počítačů pomocí specializovaného softwaru. Virtualizovat lze na různých úrovních, od 

celého počítače, tzv. virtuální stroj, po jeho hardwarové komponenty jako např. virtuální 

procesory, virtuální paměť atd. Virtuální stroj je v podstatě obraz počítače, který běží uvnitř 

jiného počítače. Takové virtuální stroje umožňují vytvářet produkty VMware. Mezi 

produkty VMware patří např. VMware Player, VMware Server, VMware Workstation  

a mnoho dalších.  

Velká část této bakalářské práce je věnována právě produktu VMware Workstation, který je 

využíván ve výuce pro virtualizaci operačních systémů. Je zde popsáno jeho využití, 

jednotlivá zařízení, požadavky na hostitelský systém a návod na instalaci. Pro úplné 

začátečníky byl vytvořen návod na použití VMware, který popisuje jak nastavení a vytvoření 

virtuálního stroje, tak celkovou práci s ním.  

A protože VMware není jediným virtualizačním nástrojem, je v práci uveden i Microsoft 

Virtual PC. Kromě jeho vlastností jsou zde popsány i požadavky na hostitelský systém, 

konfigurace virtuálního stroje a instalace hostujícího systému. 

Nakonec je produkt Microsoft Virtual PC s produkty VMware porovnán.  
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I.  TEORETICKÁ ČÁST 
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1 VIRTUALIZACE 

Jako virtualizace se v prostředí počítačů označují postupy a techniky, které umožňují  

k dostupným zdrojům přistupovat jiným způsobem, než jakým fyzicky existují, jsou 

propojeny atd. Virtualizované prostředí může být mnohem snáze přizpůsobeno potřebám 

uživatelů, snáze se používat, případně před uživateli zakrývat pro ně nepodstatné detaily 

(jako např. rozmístění hardwarových prostředků). Virtualizovat lze na různých úrovních, od 

celého počítače (tzv. virtuální stroj), po jeho jednotlivé hardwarové komponenty (např. 

virtuální procesory, virtuální paměť atd.), případně pouze softwarové prostředí (virtualizace 

operačního systému). [9] 

1.1 Příklady použití virtualizace 

- Virtuální stroj je obraz počítače, který však existuje jen jako model uvnitř jiného 

počítače. Programy běžící uvnitř tohoto stroje se chovají, jako by běžely na 

skutečném počítači, ale přitom nemohou nijak ovlivnit zbytek „vnějšího“ počítače. 

Virtuální stroje se používají z bezpečnostních důvodů pro běh některých aplikací, 

aby se tyto aplikace nemohly navzájem žádným způsobem ohrozit, ani ovládnout 

hostitelský počítač, resp. jeho operační systém. Některé programovací jazyky byly 

navrženy přímo pro běh ve virtuálním stroji a zpravidla se nepředpokládá, že by  

v nich napsané programy běžely přímo na hardwaru. Příkladem takových jazyků je 

Java či C#. Ve virtuálním stroji je možno spustit také nějaký operační systém (často 

jiný než ten, pod kterým virtuální stroj běží) a uvnitř tohoto operačního systému pak 

běžným způsobem fungovat.  

- RAID umožňuje zapojení několika disků, které se navenek tváří jako jediný, přičemž 

nabízí vyšší rychlost či odolnost proti chybám. 

- Virtuální paměť je způsob, jakým programy mohou pracovat s větším množstvím 

paměti než počítač ve skutečnosti obsahuje, odděluje paměť jednotlivých procesů 

atd.  

- Díky multitaskingu (z anglického multi = mnoho, task = úloha,  v informatice 

označuje schopnost počítače, resp. operačního systému provádět několik úloh 

současně) a threadům (z anglického thread = vlákno, v informatice označuje vlákno 
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výpočtu, tedy posloupnost po sobě jdoucích operací) může na jednom procesoru 

běžet více programů zdánlivě současně. 

- Někdy se jako součást virtualizace chápe také emulace, která umožňuje běh 

aplikací, určených pro jiné hardwarové prostředí (zcela jinou architekturu 

počítače/procesoru, např. běh programů pro ZX Spectrum na běžném PC  

s procesorem architektury x86). [9] 

1.2 Některé virtualizační systémy a emulátory 

1.2.1 Platforma x86 

1.2.1.1 Komerční software 

- VMware Workstation - virtuální stroj, určený pro provoz více OS najednou.  

V počítačích s procesorem x64 je schopen podporovat obě platformy x86 a x64. 

Podporuje nejvíce operačních systémů. 

- VMware GSX Server - virtuální stroj, určený především pro nasazení v serverech.  

V současné době jej nahradil VMware Server, který je šířen zdarma.  

- VMware ESX Server - virtuální stroj, určený především pro velké servery a jejich 

konsolidaci. [9] 

1.2.1.2 Nekomerční software 

- Bochs -  univerzální emulátor platformy x86 

- Microsoft Virtual PC 2007 - virtuální stroj, určený pro provoz více OS najednou. 

Podporuje oficiálně jen operační systémy Microsoft Windows, ale i některé 

distribuce Linuxu. Je šířen zcela zdarma i ke komerčním účelům.  

- Microsoft Virtual Server 2005 R2 - virtuální stroj, určený především pro nasazení  

v serverech. Podporuje oficiálně operační systémy Microsoft Windows a některé 

distribuce Linuxu. V počítačích s procesorem x64 je schopen podporovat obě 

platformy x86 a x64. Je šířen zcela zdarma i ke komerčním účelům.  

- Qemu - o něco rychlejší emulátor x86  
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- VDMSound - virtuální zvuková karta podporující zvuk pro DOSové aplikace běžící 

pod Microsoft Windows.  

- VMware Player - virtuální stroj, určen pouze pro běh již vytvořených virtuálních 

strojů ve VMware Workstation. Je šířen zcela zdarma i ke komerčním účelům.  

- VMware Server - virtuální stroj, nahrazuje VMware GSX Server, určený především 

pro nasazení v serverech. V počítačích s procesorem x64 je schopen podporovat obě 

platformy x86 a x64. Je šířen zcela zdarma i ke komerčním účelům.  

- Xen - linuxový virtuální stroj umožňující současný běh více OS na počítači 

architektury x86 (vyžaduje však specifické úpravy OS). [9] 

1.2.2 Další platformy 

- 1964 - emulátor Nintenda 64 

- PearPC - virtuální stroj umožňující běh operačního systému Mac OS X v Microsoft 

Windows nebo Linuxu (nad x86).  

- Qemu - rychlý emulátor několika platforem (x86, ARM, SPARC atd.)  

- VisualBoyAdvance - emulátor GameboyAdvance 

- ZSNES - emulátor NES  [9] 

1.3 Virtualizace na úrovni operačního systému 

1.3.1 Komerční 

- Cadega - umožňuje běh moderních her pro Microsoft Windows na Linuxu (vychází  

z Wine) 

- CrossOver - umožňuje běh některých aplikací (např. Microsoft Office) na Linuxu  

a MacOS (vychází z Wine) [9] 

1.3.2 Nekomerční 

- DOSBox - emulace MS-DOS pro operační systémy Linux a Microsoft Windows, 

určený především ke hraní starých her. 
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- DOSEMU - emulace hardwarového prostředí pro MS-DOS v Linuxu 

- Wine - umožňuje běh programů pro Microsoft Windows na Linuxu. [9] 
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2 VMWARE PLAYER 

VMware Player je aplikace, která umožňuje načtení a spouštění virtuálních strojů 

vytvořených v VMware Workstation, GSX Server a ESX Server. VMware Player ke své 

funkci nepotřebuje žádné z dalších produktů VMware. Jeho velkou předností je spouštění 

virtuálních strojů, vytvořených také v Microsoft Virtual PC a Virtual Server. Je volně 

šířitelný a je možné jej získat stažením ze serveru společnosti VMware nebo jej naleznete  

v základní instalaci VMware Workstation verze 5.5. 

Hodí se např. pro prezentace a předvádění nějakých řešení v praxi, využití najde zejména  

u uživatelů, kteří si chtějí vyzkoušet a otestovat nějaký systém, řešení či aplikaci v praxi bez 

nutnosti jeho plné instalace. Stačí si jen spustit dodaný virtuální stroj. 

Možnosti nastavení VMware Playeru jsou omezeny, lze pouze přiřazovat velikost operační 

paměti pro virtuální systém a nastavit typ síťového připojení virtuálního stroje do testovací  

sítě - pomocí NATu či přemostěného síťového spoje v prostředí hostitelského počítače. 

VMware Player mimo vlastní formát VMware podporuje také formáty virtuálních strojů 

Microsoftu a je dostupný ve verzích pro MS Windows i Linux. [10] 
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3 VMWARE SERVER 

VMware Server je volně šířitelný virtualizační produkt pro servery MS Windows a Linux. 

Funguje na platformě x86 případně x86_64, umožňuje také využít v hostujícím systému 

druhý procesor, pokud v počítači je. Umožňuje uživateli rychle zprovoznit nový server 

rozdělením fyzického serveru na více virtuálních strojů. Instalace a používání je přibližně 

stejně náročné na znalosti, jako je tomu u VMware Workstation. Server funguje na pozadí  

a připojuje se k němu lokálně klientem nebo přes síť. Pokud se vyskytne nějaký problém, 

klienta je možné „natvrdo sestřelit“ a přitom to Server vůbec neovlivní. Dále je tu webové 

rozhraní pro základní správu virtuálních strojů, které umožňuje zobrazit jejich stav, případně 

umožní základní konfiguraci virtuálního stroje nebo jeho zapnutí a vypnutí.  

Pro centralizovanou správu více instancí WMware Serveru je třeba použít nástroj 

VirtualCenter, který je už, bohužel, placený. 

VMware Server je vhodný pro vývojáře, testování nových verzí programů atd. Jestliže se 

vám nechce instalovat nové operační systémy do VMware, je možné zkusit už hotové 

obrazy různých systému, které jsou stáhnutelné z webu [11] VMware Technology  

Network – Virtual Appliances. [12] 
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4 VMWARE WORKSTATION 

4.1 Úvod 

VMware Workstation funguje vlastně jako počítač uvnitř počítače, což znamená, že uživatel 

si může spustit nějaký operační systém a v něm použít jakékoliv aplikace, které jsou pro něj 

určené, aniž by došlo k jakýmkoliv změnám (či omezení funkčnosti) původního operačního 

systému. Například uživatel systému Linux, který potřebuje použít nějaký program, určený 

pro systém Microsoft Windows a nedostupný na platformě Linux, si může otevřít VMware 

Workstation, v něm spustit Microsoft Windows a následně potřebný program. Pochopitelně 

VMware Workstation může být použit i obráceně – uživatelé systému Microsoft Windows, 

kteří potřebují použít nějakou aplikaci, určenou pro Linux, si ji mohou spustit ve virtuálním 

stroji. A to je pouhý nástin všech možností. 

VMware je virtuálním strojem, určeným pro počítače s procesory Intel Pentium či lepším. 

VMware je možné instalovat v prostředí systémů Microsoft Windows NT, 2000, XP, 2003  

a různých Linuxových distribucí. Software virtuálního stroje pak běží na reálném stroji  

a virtuálními stroji nabízí tutéž základní architekturu, kterou využívá i reálný stroj. Přitom 

architektura je dána typem procesoru. 

Z vnějšího pohledu se může zdát, že VMware Workstation se podobá emulátoru (tím se 

míní stroj, běžící pouze softwarově), avšak mezi virtuálním strojem typu VMware 

Workstation a emulátorem existuje jeden zásadní rozdíl, zatímco emulátor zachytává 

všechny instrukce a překládá je do podoby, vhodné pro reálný cílový stroj, virtuální stroj 

předává většinu instrukcí reálnému stroji beze změn. A protože reálný stroj je podstatně 

rychlejší než softwarový emulátor, programy, spuštěné na reálném stroji, běží vždy rychleji  

a efektivněji než na softwarovém emulátoru. Kromě toho platí, že v případě reálného stroje 

se nemusíte zabývat otázkami kompatibility do takové míry, jako v případě emulátoru, 

reálný procesor totiž stěží udělá nějakou chybu. 

Procesor počítače je těsně propojen s fyzickou pamětí počítače (RAM). VMware využívá 

výhod všech technik správy paměti, používaných v soudobých operačních systémech. Jedině 

tak lze zachovat propojení procesoru s pamětí i u virtuálního stroje. 

Nicméně i virtuální stroj musí provádět nějakou emulaci – pokud by tomu tak nebylo, 

virtuální stroj by převzal řízení celého počítače. V případě VMware Workstation se emulace 
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používá při práci s perifériemi (disky, síťové adaptéry apod.) a při využívání určitých 

privilegovaných instrukcí procesoru. Avšak i přesto, že hardware VMware je vytvářen 

softwarově, můžete reálný hardware namapovat na virtuální hardware a využívat jej zcela 

běžným způsobem. To ale znamená, že veškerá komunikace mezi reálným hardwarem  

a virtuálním strojem prochází přes několik dalších vrstev, což vede k určitému zpoždění; na 

druhou stranu však tato abstrakce umožňuje použití některých funkcí, které toto zpoždění 

více než vyvažují. Typickým příkladem může být odpojování a připojování zařízení. [1] 

4.1.1 Pojmy 

Pojem hostitelský a hostující počítač popisuje váš fyzický a virtuální počítač: 

- Fyzický počítač, na kterém je nainstalován VMware Workstation software, 

označujeme jako hostitelský počítač. Operační systém pak nazýváme hostitelský 

operační systém. 

- Operační systém, běžící ve virtuálním (hostujícím) počítači, označujeme jako 

hostující operační systém. 

4.1.2 Využití VMware 

- Běh více operačních systémů probíhajících současně na jednom fyzickém stroji – 

VMware je software, který umožňuje provoz více x86 systému na jednom PC, 

obsahující systémy jako jsou Microsoft Windows, Linux, NetWare, a jejich aplikací 

bez restartování nebo rozdělení pevného disku. Výsledkem jsou redukované náklady 

na hardware a rychlejší přístup k různým zařízením. 

- Vývoj softwaru a testování - VMware Workstation přináší urychlení vývoje softwarů  

a testování, vytváření více vývojových a testovacích zařízení, jako jsou virtuální 

stroje, za využití jednoho PC. Vývojáři tak mohou vytvářet testovací prostředí 

složené z více virtuálních strojů, které pak použijí pro snadnější vývoj a testování 

aplikací na více operačních systémech, nebo pro rychlé vytváření a testování aplikací 

na více nezávislých virtuálních sítích v rámci jednoho PC. 

- Použití VMware sebou přináší i další výhody – například pokud by testování mohlo 

vést k poškození operačního systému hostitelského systému, je možné využít 

speciální režim virtuálních disků VMware. Dojde-li k poškození virtuálního disku, je 
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možné se vrátit k přecházejícímu stavu systému. V případě reálného systému by 

takové poškození obvykle znamenalo reinstalace operačního systému. [1] 

4.1.3 Soubory virtuálního stroje 

Virtuální počítače typicky sestávají z několika souborů, rozlišených podle přípon: 

- LOG jsou malé soubory, které popisují klíčové aktivity virtuálního stroje. 

- NVRAM jsou soubory, které ukládají stav BIOSu virtuálního stroje. 

- VMX jsou malé soubory, které popisují konfiguraci počítače. 

- VMDK jsou velké soubory, které reprezentují virtuální hard disky.  

- VMSN jsou soubory snímků, které ukládají stav virtuálního stroje. 

- VMSS jsou soubory, které ukládají  stav virtuálního stroje po přepnutí do úsporného 

režimu. 

Dalšími příponami, které VMware vytváří, mohou být např. VMTM,VMSD,VMEM. 

4.2 Virtuální stroj VMware 

VMware Workstation vytváří virtuální hardware nad reálným hardwarem (procesorem, 

pamětí) hostitelského počítače. 

4.2.1 Procesor, sběrnice, paměť a přerušeni 

Počítač třídy PC má tři základní komponenty: CPU, paměť a vstupně/výstupní zařízení. 

Zkratka CPU pochází z anglických slov Central Processing Unit a označuje skutečné srdce 

počítače. Běžně se používá označení procesor. Procesor není využíván pouze k provádění 

jednotlivých instrukcí, tvořících nějaký program, ale i k řízení zbývajících částí systému. 

A protože procesor není schopen uložit všechna důležitá systémová data do své paměti, 

která je z hlediska velikosti značně omezená, potřebuje ke své práci i nějakou vnější paměť.  

Ta mívá podobu paměti RAM (z anglického Random Access Memory – paměť s náhodným 

přístupem). Jelikož je tato paměť pro procesor velmi důležitá, má k ní procesor téměř přímý 

přístup. Mezi procesorem a pamětí se nachází vrstva, které se říká jednotka správy paměti 

(MMU – Memory Management Unit). Ta dělí celou paměť RAM na malé části, nazývané 
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stránky. Současné si jednotka správy paměti udržuje tabulku stránek, v níž je uložen vztah 

mezi adresami paměti a jednotlivými stránkami. 

Paměť, využívána uživatelskými programy, se nazývá virtuální paměť. Jakmile si procesor 

vyžádá obsah nějaké adresy v paměti, jednotka správy paměti načte z tabulky stránek 

odpovídající adresu fyzické paměti a zajistí načtení obsahu správné adresy. Má-li být překlad 

adres proveden, musí operační systém spolupracovat s MMU.  

Na druhou stranu jen stěží najdete nějaké zařízení, které by mělo jakékoli přímé připojení  

k procesoru. Příčiny jsou dvě: zaprvé je to značný počet různých zařízení, lišících se natolik, 

že je téměř nemožné vytvořit v procesoru nějaké rozhraní, které by bylo schopné 

podporovat každé zařízení. A zadruhé různá zařízení vysílají data v různé časové okamžiky, 

v důsledku čehož se může stát, že se několik zařízení bude současně snažit komunikovat  

s procesorem. Nemá smysl, aby se procesor věnoval nějakému zařízení ještě předtím, než 

jsou všechna data vysílaná zařízením, uspořádána v takovém formátu, kterému procesor 

rozumí. Z tohoto důvodu je procesor připojen ke společné sběrnici, k niž jsou připojena  

i všechna zařízení. Kromě toho v mnoha případech se ještě používají speciální řadiče  

a rozhraní, nacházející se mezi zařízením a sběrnicí: typickým příkladem může být např. 

řadič SCSI. 

Součástí VMware jsou virtuální sběrnice, podobající se těm, které najdete i v moderním PC. 

Jednou z nich je sběrnice PCI a druhou rozšíření této sběrnice, nazývané PCI-to-ISA bridge. 

Sběrnice ISA představuje zastaralý standard. A ačkoliv se výkonově tato sběrnice vůbec 

nemůže srovnávat se soudobými standardy, z důvodu zpětné kompatibility je stále 

udržována. 

I když některá zařízení, k nimž patří např. sériové porty, stále ještě využívají rozhraní ISA, 

vývojáři hardwaru se mu snaží vyhnout, neboť jeho využívání je spojeno s mnoha 

omezeními. Některá z těchto omezení jsou dána přerušením a vstupně/výstupními porty. 

Kdykoliv je totiž nějaké zařízení připraveno vyslat svoje data do procesoru či chce procesor 

sdělit nějakou jinou důležitou informací, odešle po sběrnici přerušení. Procesor jej 

zaregistruje, přeruší svou aktuální činnost a přijaté přerušení zpracuje. Sběrnice ISA 

rozlišuje jednotlivá přerušení tím, že jim přiděluje čísla IRQ (Interrupt Request Level). 

Protože ale není možné využívat příliš mnoho čísel, mohou nastat situace, kdy se dvě různá 

zařízení budou snažit o využití téhož přerušení. Výsledkem mohou být velmi vážné konflikty 
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zařízení, vedoucí k jejich nefunkčnosti. Podobně platí, že ke komunikaci mezi zařízeními  

a procesorem jsou využívány i vstupně/výstupní porty. 

Sběrnice PCI nemá ani jeden z popsaných problémů. Přerušení sběrnice PCI totiž obsahuje 

podstatně více informací, což znamená, že několik PCI zařízení může sdílet jedno přerušení. 

Čipová sada je navíc schopna po zapnutí počítače automaticky přiřadit vstupně/výstupní 

porty.  

Na obrázku 1 se nachází schéma hardwaru VMware Workstation. Je tady poměrně zvláštní 

umístění rozhraní PCI IDE disků, k němuž je možno přistupovat jak přes sběrnici PCI,  

tak přes sběrnici ISA. [1] 

 

Obrázek 1: reálný hardware a virtuální hardware 

4.2.2 Zařízení VMware 

4.2.2.1 IDE disky a CD-ROM mechaniky 

V počítačích PC se nejčastěji používají disky IDE (z anglického Integrated Device 

Elecktronics). Původní disky se od současných lišily. Na základní desce počítače se 

nacházel řadič disku, propojený se samotným diskem vyhrazeným (a odděleným) datovým 

kanálem. Tyto řadiče však zvyšovaly cenu počítačů. Navíc v mnoha případech tyto řadiče 

nabízely vlastnosti a funkce, které běžné PC vyžaduje – např. řadiče SCSI-I či SCSI-II jsou 

schopné pracovat až se 7 disky či jinými zařízeními. Běžné PC však jen málokdy má více 

než 1 či 2 disky. Další komponenty mívají obvykle podobu rozšiřujících karet s rozhraním 
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ISA či PCI. Z tohoto důvodu se vývojáři rozhodli omezit funkce řadiče disku a tak snížit 

cenu počítače. Výsledkem jejich vývoje byly IDE disky, u nichž byly tyto řadiče 

integrovanou součástí.  

S nárůstem popularity se IDE disky staly velmi rychle nejčastěji používanými typy disků. 

Nicméně určitá omezení, která jsou součástí původního návrhu IDE, způsobovala pozdější 

problémy. Kdykoliv pak vznikl nový problém, nějaký vývojář přidal k původní specifikace 

nový „standard“. Typickým příkladem mohou být CD-ROM mechaniky, kdy původní 

specifikace IDE jej vůbec nepodporovala, a proto vývojáři hardwaru zahrnuli do specifikace 

IDE i standard ATAPI (z anglického AT Attached Packet Interface, jde o standard, 

umožňující připojení CD-ROM k rozhraní IDE).  

Podobně jako většina základních desek, tak i VMware Workstation nabízí dva IDE řadiče, 

nazývané primární a sekundární. Přerušení a vstupně/výstupní porty přiřazené k tomuto 

rozhraní naleznete v tabulce 1. 

Rozhraní IRQ Vstupně/výstupní porty 
IDE0 14  0x1f0-0x1f7, 0x3f6 
IDE1 15  0x170-0x177, 0x376 

Tabulka 1: přerušení a I/O porty 

Podobně jako reálné IDE rozhraní, může podporovat maximálně 2 zařízení (označována 

jako master a slave). V prostředí VMware se může jednat jak o pevné disky, tak  

i o mechaniky CD-ROM/DVD-ROM, CD-R a CD-RW.  

VMware ukládá virtuální a běžné disky do souborů, nacházejících se na pevném disku 

hostitelského systému. Tyto soubory jsou obrazy celého virtuálního disku, a proto bývají 

poměrně veliké.  

VMware disky vám nabízí i některé vlastnosti, se kterými se u reálných disků nesetkáte. 

Například to může být možnost zrušení všech změn či zdánlivé označení disku pro čtení  

i zápis, aniž by docházelo k jakýmkoliv změnám výchozích dat. Kromě toho CD-ROM 

mechaniky je možné ve VMware nakonfigurovat jako mapování reálného disku. A nachází-li 

se obraz CD-ROM na hostitelském systému (např. soubor ve formátu ISO), je možné  

ve VMware vytvořit CD-ROM mechaniku, která se bude odkazovat na tento obraz. [1]  
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4.2.2.2 SCSI Disky 

Rozhraní SCSI (z anglického Small Computer System Interface) je standardem sběrnice 

sloužící pro připojování periférii, tj. různých zařízení, k počítači. Tato sběrnice je nezávislá  

na architektuře počítače, což znamená, že je možné jej např. přenášet mezi počítači PC  

a Apple, za předpokladu dostupnosti ovladačů, potřebných k zpřístupnění takového 

zařízení. Brána mezi sběrnicí SCSI a počítačem se nazývá hostitelským řadičem SCSI. 

Existuje několik typů SCSI sběrnic: SCSI-I, SCSI-II, Fast SCSI-II, Ultra Wide SCSI apod.  

Ke sběrnicím SCSI-I a SCSI-II lze připojit až 8 zařízení. Naopak sběrnice Wide SCSI  

a novější dokáží pracovat až se 16 zařízeními.  

Součástí VMware Workstation je i virtuální SCSI hardware. Speciální režimy a vlastnosti 

SCSI disků ve VMware jsou shodné s IDE diky, popsanými v předcházející části. A protože 

virtuální SCSI řadič má rozhraní PCI, systém mu při svém startu přiděluje přerušení IRQ  

a číslo vstupně/výstupního portu dynamicky. [1] 

4.2.2.3 Disketové mechaniky 

Nejjednodušším zařízením, které VMware podporuje, je disketová mechanika. Zatímco 

ostatní platformy dokáží s disketovou mechanikou pracovat velmi pokročilým způsobem 

(např. dokáží automaticky detekovat typ media či jej vysunout), v případě PC musí být 

všechny úkony prováděny ručně. Stejně jako u samotné diskety ani hardwarové specifikace 

disketových mechanik se v posledních letech prakticky vůbec nezměnily. Řadič disketové 

mechaniky u PC není ani dokonce schopen automaticky zjistit, zda je mechanika připojena 

či jakou kapacitu médií daná mechanika podporuje. Jinými slovy řečeno, řadič se pouze 

snaží najít médium, a pokud se mu ho nepodaří nalézt, jednoduše oznámí operačnímu 

systému, že s daným médiem nedokáže pracovat. 

V hostujícím systému je možné namapovat jednu či dvě virtuální disketové mechaniky  

na reálné disketové mechaniky nebo na obrazy disket, umístěné v hostitelském operačním 

systému. Práce s disketami je v prostředí VMware velice výhodná. Diskety jsou totiž nejen 

nespolehlivé, ale i pomalé. Nakopírováním obrazu nějaké diskety na pevný disk 

hostitelského systému a následným vytvořením odkazu ve VMware na tento obraz 

umožňuje, aby byla práce s ním podstatně rychlejší.  
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Řadič disketové mechaniky využívá u PC přerušení IRQ 6 a vstupně/výstupní porty 0x3f0 

až 0x3f5 a 0x3f7. 

Dodavatelé hardwaru začali nabízet disketové mechaniky s rozhraním USB či dokonce IDE, 

aby se tak vyhnuli nevýhodám, spojeným s provozem disketových mechanik. Ve VMwaru je 

možné namapovat virtuální SCSI mechaniku též jako klasickou disketovou mechaniku. 

Nicméně výhody konfigurace nejsou příliš velké. Proto pokud vás bude zajímat obsah 

nějaké diskety, pak je podstatně jednodušší vytvořit si v hostitelském systému obraz této 

diskety a poté disketu zahodit. [1] 

4.2.2.4 Síťové rozhraní 

Síťovým adaptérem (NIC – Network Interface Card) se rozumí adaptér, schopný 

zachycovat signály v síti, filtrovat je a nakonec předat procesoru k dalšímu zpracování. 

Pro vytváření lokálních počítačových síti se nejčastěji používají sítě typu Ethernet.  

V důsledku nízkých cen, se začaly do počítačů montovat základní desky s integrovanými 

síťovými adaptéry.  

Ve virtuálním stroji VMware je možno vytvořit až tři síťové adaptéry, přičemž každý z nich 

může být nakonfigurován jedním ze tři možných způsobů. Prvním z nich je hostitelská síť, 

existující pouze v hostitelském operačním systému a používaná především pro komunikaci 

mezi hostitelským a hostujícím systémem. V případě konfigurace mostová síť je hostující 

systém schopen komunikovat přímo se sítí, ke které je připojen hostitelský počítač. 

Posledním typem je NAT síť, což je hostitelská síť, využívající pro komunikaci s vnějšími 

sítěmi překlad síťových adres (NAT – Network Address Translation). 

Podobně jako SCSI řadič i virtuální síťové adaptéry mají ve VMware rozhraní PCI, což 

znamená, že přerušení a vstupně/výstupní adresy jsou přiřazovány dynamicky při startu 

systému. 

Nastavení sítě ve VMware umožňuje plné využití reálné sítě, počínaje SSH tunelováním  

a konče využíváním vzdálených tiskových serverů. [1] 

4.2.2.5 Sériové porty 

Sériové porty jsou starším typem periferního rozhraní, umožňující přenos dat mezi dvěma 

zařízeními bit po bitu. Sériová komunikace se nejčastěji používá při přenosech dat mezi 
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počítačem a modemem. Čip, který zajišťuje tuto komunikaci, se obvykle označuje zkratkou 

UART (z anglického Universal Asynchronous Receiver – Transmitter). U současných 

základních desek jsou tyto čipy integrovány přímo do čipové sady. 

Parametry čipů UART po dlouhou dobu nevyhovovaly požadavkům. Původní čipy 8250  

a 16450 totiž neměly dostatek velké zásobníky a nebyly tedy schopné ukládat příchozí 

znaky. U systémů DOS nebyl toto žádný problém, neboť v těchto systémech nebylo nikdy 

spuštěno více procesů najednou. Avšak skutečné operační systémy, sloužící i k jiným 

účelům než jen ke spouštění dalších programů, na tento problém narazily. Čipy UART 

mnohdy přepsaly příslušný zásobník dříve, než byl jeho obsah načten operačním systémem. 

O vyřešení problému se snažili tvůrci čipu 16550, jehož součástí byl zásobník FIFO. 

Bohužel však tyto čipy měly jednu zásadní chybu, kvůli kterým byl tento zásobník 

nepoužitelný. Reakcí na tuto chybu vznikl čip 16550A, který je používán až do dnešní doby. 

Součástí VMware Workstation jsou čtyři sériové porty s virtuálními čipy 16550A. Tyto 

porty mají pevně danou konfiguraci, odpovídající výchozí konfiguraci PC. Jednotlivé 

parametry naleznete v tabulce 2. 

Název v DOSu 
Název v 
Linuxu IRQ 

Vstupně/výstupní 
porty 

COM1 /dev/ttyS0 4 0x3f8 až 0x3ff 
COM2 /dev/ttyS1 3 0x2f8 až 0x2ff 
COM3 /dev/ttyS2 4 0x3e8 až 0x3ef 
COM4 /dev/ttyS3 3 0x2e8 až 0x2ef 

Tabulka 2: přerušení a I/O porty 

V prostředí VMware lze připojit k sériovým portům skutečná zařízení, přesměrovávat jejich 

výstup do souborů na hostitelském systému. [1] 

4.2.2.6 Paralelní porty 

Na rozdíl od sériových portů, přenášející data bit po bitu, paralelní port přenáší osm bitů 

najednou. Cílem původního návrhu bylo vytvořit především jednosměrný port, vhodný pro 

připojení zařízení, nevyžadujících velké přenosové rychlosti (typickým příkladem mohou být 

tiskárny). V průběhu doby však paralelní porty postupně získávaly schopnost přenášet data 

oběma směry, což znamenalo, že připojená zařízení mohla začít odesílat nějaké informace 

do počítače. Ačkoliv jejich přenosová rychlost není nijak vysoká a využívání více zařízení, 
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připojených k jednomu paralelnímu portu, je více než problematické, jsou tyto porty 

součástí prakticky všech PC.  

VMware Workstation podporuje dva paralelní porty PC, a to jak v jednosměrném, tak  

i obousměrném režimu. Jednotlivé parametry paralelního portu naleznete v tabulce 3. [1] 

Název v DOSu Název v Linuxu IRQ Vstupně/výstupní porty 
LPT1 /dev/lp0,/dev/parport0 7 0x3bc až 0x3be 
LPT2 /dev/lp1,/dev/parport1 5 0x378 až 0x37f 

Tabulka 3: přerušení a I/O porty 

4.2.2.7 Rozhraní USB 

VMware Workstation podporuje univerzální sériovou sběrnici (USB – z anglického 

Universal Serial Bus) už od verze 3. Jedná se o poměrně moderní typ sběrnice, nabízející 

středně vysoké přenosové rychlosti. Tato sběrnice je vhodná především pro připojování 

periférii, jako např. klávesnic, myší, tiskáren, skenerů a přenosných médií. Sběrnice 

podporuje připojování a odpojování zařízení za provozu, což znamená, že kvůli připojování 

nějakého zařízení nemusíte vypínat počítač. Další výhodou je, že zařízení, nemající příliš 

vysokou spotřebu, mohou být napájena přímo ze sběrnice. Samotný přenos dat po sběrnici 

USB se podobá přenosu dat přes sériové porty, avšak na rozdíl od nich sběrnice USB 

podporuje připojení více zařízení. U USB sběrnice jsou jednotlivá zařízení propojená  

s hostitelským adaptérem jako kořenem stromu zařízení. Tento strom se pak větví  

v rozbočovačích sběrnice a končí v jednotlivých zařízeních. Mnohá zařízení obsahují 

vestavěné rozbočovače. 

Virtuální USB ve VMware Workstation emuluje rozhraní universálního hostitelského řadiče 

(UHCI – z anglického Universal Host Controller Interface), což je konkrétní hardwarová 

specifikace. Kterýkoliv operační systém, podporující USB, by pak měl být schopen tento 

hardware podporovat. VMware mapuje hostitelský řadič USB reálného systému na virtuální 

řadič. Podobně jako u ostatních PCI zařízení i u rozhraní USB platí, že přerušení  

a vstupně/výstupní porty virtuálního rozhraní závisí na konfiguraci daného virtuálního 

stroje. [1] 
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4.2.2.8 Grafické adaptéry 

U počítačů PC slouží grafický adaptér i k něčemu jinému než jen k pouhému propojení 

počítače s monitorem, jeho součástí je i paměť, v niž jsou uchovávána data o barvách všech 

bodů na obrazovce. Kromě toho grafický adaptér obsahuje procesor, schopný provádět 

grafické výpočty a kreslit složité struktury. V počátcích vývoje osobních počítačů se 

používalo několik různých nekompatibilních grafických standardů. Poté se však objevil 

standard VGA (z anglického Video Graphics Array), který byl přijat všemi výrobci. Všechny 

novější standardy z něj vycházejí a propracovávají se dále. Součástí standardu VGA jsou 

textové režimy, například 25 řádků textu po 80 znacích (sloupcích), umožňující pouze 

zobrazování textu a 16barevný grafický režim, umožňující zobrazení 640 pixelů (bodů) ve 

směru vodorovném a 480 pixelů ve směru svislém (tomuto režimu se také říká VGA 16). 

Téměř okamžitě po přijetí tohoto grafického standardu jej výrobci začali různými způsoby 

rozšiřovat, neboť standard VGA nenabízí možnost použití dostatečného množství barev ani 

požadovaného vysokého rozlišení. Tyto upravené standardy se obecně nazývají SVGA 

(Super VGA), byť žádné skutečné standardy pro vyšší rozlišení a větší množství barev 

neexistují.  

Virtuální grafické adaptéry VMware Workstation pracují zcela stejným způsobem. Adaptér 

podporuje standardní režim VGA a kromě něj i SVGA rozšíření, umožňující použití 

prakticky libovolného rozlišení s tím počtem barev, který je nastaven i v hostitelském 

systému. Toto rozšíření standardu VGA je možné použít jen tehdy, je-li v hostujícím 

systému nainstalována sada VMware Tools. Kromě toho, že tato sada vylepší grafické 

možnosti hostujícího systému, přispěje i k výraznému zvýšení grafického výkonu, neboť 

nástroje z této sady komunikují přímo s VMware v hostitelském systému a obchází tak 

několik vrstev virtuálních zařízení. [1] 

4.2.2.9 Myš 

Součástí platformy počítačů PS/2, vyvinuté firmou IBM, byl i nový port pro pomocné 

zařízení PS/2. V průběhu doby se tento port začal využívat především pro připojení myši  

a lze říci, že v současné době je v této oblasti standardem. Tyto porty využívají přerušení 

IRQ 12 a sdílí vstupně/výstupní porty s klávesnicí PC (0x060 až 0x06f). 
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VMware přebírá události, vytvořené myší, z hostitelského operačního systému a předává je 

do své vlastní myši standardu PS/2. Pokud je v hostujícím systému nainstalován VMware 

Tools je možné použít i několik speciálních funkcí, díky kterým bude myš zcela 

transparentně spolupracovat s hostujícím systémem.  

Starší typy myší se většinou připojovaly k sériovým portům počítačů. VMware Workstation 

pochopitelně podporuje i takovou konfiguraci, neboť jak již bylo řečeno výše, VMware 

umožňuje používání sériových zařízení. [1] 

4.2.2.10 Zvukové adaptéry 

Existuje mnoho různých druhů zvukových adaptérů, lišících se svými vlastními 

hardwarovými schématy. Platí však, že všechny zvukové adaptéry mají alespoň něco 

společné. VMware Workstation převádí zvukové zařízení hostitelského systému na adaptér 

Creative Technology SoundBlaster 16, standardně využívající přerušení IRQ 5, 

vstupně/výstupní porty 0x220 až 0x22f a kanál přímého přístupu do paměti (16bitový DMA 

kanál 5). A protože toto jsou výchozí hodnoty pro většinu ovladačů, neměla by podpora  

v hostujícím systému být žádným problémem. Je však nutné zdůraznit, že VMware nemusí 

podporovat všechny vlastnosti a funkce. [1]  

4.2.3 BIOS počítačů PC 

Všechny počítače PC mají BIOS (Basic Input/Output System neboli základní 

vstupně/výstupní systém), kterým je poměrně krátký firmware, uložený v čipech základní 

desky. BIOS ví, jak má, velmi omezeným a základním způsobem, komunikovat s celou 

řadou zařízení, z nichž PC sestává.  

Starší operační systémy (ke kterým patří např. DOS) využívaly pro komunikaci  

s hardwarem právě BIOS, ale všechny novější systémy potřebují BIOS pouze pro základní 

konfiguraci a samotné bootování. Po zapnutí počítače provádí BIOS test paměti a kontrolu 

zda jsou připojeny základní periférie. Pokud jsou testy úspěšné, jsou ukončeny krátkým 

pípnutím. BIOS také může zajišťovat zobrazování mnoha druhů informací o konfiguraci 

počítače.  

K nejzákladnějším možnostem, které najdete v každém BIOSu, patří konfigurace disketové 

mechaniky, pevných disků, nastavení pořadí mechanik, z nichž bude zaváděn operační 
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systém, a upřesnění parametrů správy napájení. Některé BIOSy nabízejí ještě spoustu 

dalších voleb. Avšak bez ohledu na ozdůbky, jimiž jsou některé BIOSy vybaveny, platí, že 

každý BIOS musí zadané hodnoty někam uložit, aby je uživatel nemusel znovu zadávat po 

každém zapnutí počítače. Obvykle se k tomuto účelu používá paměť NVRAM  

(z anglického NonVolatile RAM), tvořená čipy typu Flash ROM anebo udržovaná malou 

baterií. 

Podobně jako skutečné PC i VMware Workstation má svůj vlastní BIOS, vycházející  

z BIOSu firmy Phoenix. VMware ukládá paměť BIOSu do souboru (viz. kapitola 4.1.3 

Soubory virtuálního stroje) v hostitelském systému. 

Další komponentou základní desky počítače, mající těsnou vazbu na BIOS, jsou hodiny 

reálného času (RTC – Real Time Clock). Jedná se o malé, baterií poháněné digitální hodiny, 

které fungují i v době, kdy je počítač vypnut. Běžně se tyto hodiny používají pro nastavení 

data a času při bootování operačního systému. VMware mapuje RTC hostitelského systému 

na virtuální zařízení. Pokud nějaká jiná součást počítače využívá RTC, pak VMware tyto 

hodiny emuluje na základě časových signálů z hostitelského operačního systému, to však 

není totéž jako využívání RTC. [1] 

4.2.4 Jak počítač bootuje 

První etapy tohoto procesu jsou řízeny BIOSem. A protože existuje několik možných 

způsobů bootování počítače (z diskety, z pevného disku, z CD či dokonce ze sítě), 

prohledává BIOS tato zařízení v pořadí, ve kterém je uživatel nastaví. Může se tedy stát, že 

BIOS se nejprve pokusí vyhledat spouštěcí médium v disketové mechanice, a teprve pokud 

v ní nic nenalezne, začne hledat spouštěcí blok např. na pevném disku nebo na médiu  

v CD-ROM mechanice atd. 

S každým z uvedených zařízení však BIOS pracuje poněkud odlišným způsobem. Diskety 

jsou poměrně jednoduchým médiem, majícím spouštěcí sektor s pevně danou polohou. 

Pokud je v tomto sektoru uložen nějaký kód, umožní spuštění programu, nacházejícího se 

na disketě. A protože diskety obvykle nemají žádnou tabulku oddílů, je toto bootování 

vcelku spolehlivé. V případě CD médií je situace poněkud složitější. Obvykle musíte někam 

do souborového systému CD média uložit obraz spouštěcí diskety a aktivovat speciální 

rozšíření standardu ISO 9660 tak, aby na tento obraz ukazovalo. 
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Pevné disky jsou ze všech dosud uvedených médií nejsložitější, neboť obsahují tabulky 

oddílů. Kód, umožňující zavádění operačního systému (tzv. zavaděč), se obvykle ukládá na 

ten oddíl, v němž je nainstalován operační systém. Pomocí speciálního programu, kterým je 

např. fdisk, pak daný oddíl označíte v tabulce oddílů jako aktivní. Nicméně v době 

bootování BIOS načítá obsah prvního sektoru na pevném disku, kterému se proto říká 

hlavní spouštěcí záznam (MBR – Master Boot Record). Přitom platí, že BIOS spustí 

jakýkoliv kód, který v tomto oddílu najde. Obvykle se ale jedná o velmi krátký program, 

snažící se o vyhledání aktivního oddílu v tabulce oddílů. Je-li nějaký takový oddíl nalezen, 

pokusí se BIOS načíst spouštěcí sektor tohoto oddílu (jehož obsah tvoří právě zavaděč 

daného operačního systému). 

Bude-li na jednom disku nainstalováno několik operačních systémů, můžou nastat 

problémy. Některé zavaděče, jako např. zavaděč Linuxu (LILO – LInux Loader), jsou však 

schopné načítat obsah spouštěcích sektorů na jiných oddílech. Tato vlastnost se běžně 

využívá např. u počítačů, umožňující spouštění buď Microsoft Windows anebo Linuxu. 

BIOS nejprve načte LILO z aktivního spouštěcího sektoru (obvykle se nacházejícího na 

linuxovém diskovém oddíle) a umožní „přeskočení“ do spouštěcího sektoru na oddíle 

s Microsoft Windows. [1] 

4.3 Instalace VMware Workstation 

Instalace VMware Workstation je poměrně jednoduchá a srozumitelná. Z důvodu usnadnění 

administrace je VMware navržen tak, aby byl poměrně nezávislý na hostitelském systému  

a neprováděl v něm při instalaci příliš mnoho změn. Je však pochopitelné, že k určitým 

změnám na hostitelském systému dojít musí, ovšem instalační proces tyto skutečnosti před 

vámi nijak neskrývá. 

4.3.1 Požadavky na hostitelský systém 

Instalace VMware Workstation nevyžaduje, z dnešního pohledu, nijak výkonný systém. 

Procesor musí být Intel Pentium či lepší (což znamená, že stačí jakýkoliv procesor, 

vyrobený firmami Intel či AMD v posledních letech). Z hlediska technického příliš nezáleží 

na rychlosti procesoru, nicméně sama firma VMware, Inc. doporučuje procesor o minimální 

rychlosti 266MHz.  
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Otázkou rychlosti procesoru je třeba se zabývat v případě výběru hostujícího systému. 

Hostujícímu systému, nemajícímu příliš vysoké nároky na procesor (například Linux bez 

jakéhokoliv grafického rozhraní), vystačí i pomalejší procesor. 

Požadavky na paměti jsou zcela odlišné. Hostující systém na virtuálním stroji vyžaduje 

zhruba tolik paměti, jako při provozu na reálném stroji. Z toho vyplývá, že minimální 

velikost paměti závisí na součtu velikosti paměti potřebné pro provoz hostujícího  

a hostitelského systému.  

Grafický adaptér by měl být nastaven do režimu, využívajícího 16bitovou či větší barevnou 

hloubku. U systémů Microsoft Windows NT/2000/XP je možno toto nastavení najít na kartě 

Nastavení, kterou lze otevřít klepnutím pravého tlačítka myší na ploše obrazovky. V poli 

Barvy by mělo být uvedeno Střední – 16 bitů (High Color) nebo Nejvyšší – 32 bitů 

(True Color). V případě hostitelského počítače se systémem Linux není barevná hloubka 

tak významným kritériem.  

Požadavky na prostor na pevném disku jsou různé. Samotný systém VMware Workstation 

vyžaduje pouze okolo 100MB, avšak uložení samotného hostujícího sytému nebo uspávání 

tohoto systému vyžaduje podstatně více volného místa. [1] 

Podporované hostitelské systémy jsou: 
- Microsoft Windows NT 4.0, 2000, XP, 2003, Vista 
- GNU Linux s jádrem 2.2 a vyšší 

4.3.2 Instalace VMware Workstation 

Podrobný návod na instalaci VMware Workstation najdete v příloze P I. 

4.4 Návod na použití VMware Workstation 

Podrobný návod na použití VMware Workstation verze 5.5 naleznete v příloze P V. 
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5 VIRTUAL PC 2007 

Další aplikací určenou k virtualizaci je Microsoft Virtual PC. Microsoft Virtual PC 2007 je 

k dispozici zdarma a je možné jej stáhnout ze stránek [13] společnosti Microsoft.  

5.1 Požadavky na hostitelský systém 

Hardwarové požadavky závisí na tom, jaké virtuální stroje se na něm budou provozovat. 

Největší nároky se kladou hlavně na rychlost procesoru, paměť a na diskový prostor. 

- procesor - otázkou rychlosti procesoru je třeba se zabývat v případě výběru 

hostujícího systému 

- paměť - hostující systém na virtuálním stroji vyžaduje zhruba tolik paměti, jako při 

provozu na reálném stroji. Z toho vyplývá, že minimální velikost paměti závisí na 

součtu velikosti paměti potřebné pro provoz hostujícího a hostitelského systému. 

- diskový prostor - virtuální hard disky jednotlivých obrazů systému jsou na disku 

ukládány jako samostatné soubory o velikosti několika gigabajtů 

- podporovaný hostitelský systém – Microsoft Windows XP, 2003, Vista 

5.2 Soubory virtuálního stroje 

Virtuální počítače typicky sestávají z několika souborů, rozlišených podle přípon: 

- VMC jsou malé XML soubory, které popisují konfiguraci počítače. 

- VHD jsou velké soubory, které reprezentují virtuální hard disky. 

- VFD jsou obrazy disket. 

- VSV jsou dočasně existující soubory, které vzniknou, pokud vypnete virtuální 

počítač a uložíte jeho stav. V takovém případě se obsah jeho paměti uloží do tohoto 

souboru.  

5.3 Instalace hostujícího systému 

Instalace nového virtuálního stroje na MS Virtual PC 2007 probíhá zcela standardně. Po 

spuštění vás uvítá hlavní okno aplikace. Kliknutím na New se zobrazí průvodce vytvořením 

nového virtuálního stroje. Při vytváření je možno vybrat si z několika variant (nový, nový  
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s výchozím nastavením nebo existující virtuální stroj). Tyto varianty jsou z velké části 

podobné jako u VMware Workstation. Poté se musí zadat umístění a název souborů nového 

stroje, druh vytvářeného systému a množství paměti. Dále se vás instalační průvodce zeptá, 

zda-li se bude pokračovat vytvářením nového virtuálního disku nebo se použije již existující. 

V posledním kroku se musí zadat kapacita vytvářeného disku.  

Vybráním právě vytvořeného virtuálního stroje, který najdeme v hlavním okně, je už nyní 

možné kliknout na tlačítko Settings. Zde se nastavuje hardware, jejž má MS Virtual PC 

emulovat. Lze přizpůsobit velikost alokované paměti, připojit další virtuální pevné disky, 

vytvořit Undo disk (dočasný disk, z něhož lze vrátit veškeré provedené změny), připojit 

CD/DVD a disketové mechaniky, sériové i paralelní porty, zvukovou kartu, myš a dále 

konfigurovat zobrazení, sdílení složek či podporu hardwarové virtualizace. Toto nastavení 

lze provádět pouze, pokud je virtuální počítač vypnutý. 

Tlačítkem Start je již možné nakonfigurovaný virtuální stroj spustit. Avšak počítač je dosud 

bez operačního systému, proto je nutné jej nainstalovat. Bude-li se instalace provádět  

z obrazu instalačního CD, je nutné v nabídce zvolit CD > Capture ISO image. V případě 

instalace z fyzické mechaniky vybrat CD > Use Physical Drive. Nyní stačí jen virtuální stroj 

restartovat a začít s instalací operačního systému. Samotná instalace hostujícího systému se 

provádí stejným způsobem jako instalace na reálném počítači. [14] 

5.4 Konfigurace virtuálního stroje 

K virtuálnímu stroji je možno připojit až tři virtuální hard disky v podobě souborů nebo 

namapovaného fyzického disku. Disky jsou připojeny k virtuálnímu IDE řadiči. MS Virtual 

PC nepodporuje virtuální SCSI řadiče. Pokud je povolen undo disks, budou se změny 

ukládat do zvláštního souboru a při vypínání virtuálního počítače bude možné změny nechat 

jak jsou, definitivně je potvrdit a nebo zrušit. Tato funkce je náročnější na diskový prostor, 

ale pro rozličné testování a pokusy může být velice užitečná. 

Virtuální CD/DVD nebo floppy mechanika se umí napojit na fyzickou mechaniku vašeho 

počítače a nebo připojit soubor s image. 

Obdobným způsobem lze připojit sériové a paralelní porty. 

Velmi důležitá je sekce Networking. Počítač může mít až čtyři virtuální síťové karty,  

u nichž je možno vybrat, v jakém režimu budou: 
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- Not connected - síťová karta není nikam připojena, počítač se chová, jako by do ní 

nebyl zasunut kabel 

- Local only - bude vytvořena virtuální síť, která umožní komunikovat více současně 

spuštěným virtuálním počítačům mezi sebou. Nebude možno komunikovat s reálnou 

sítí ani s hostitelským počítačem.  

- Shared networking (NAT) - hostitelský počítač se bude chovat jako router  

s NATem. Virtuální počítač bude přes DHCP přidělovat adresu z rozsahu 

192.168.131.x. Bude schopen se připojit na vnější síť, ale nikoliv naopak, protože 

jednoduchý NAT nepodporuje "inbound port mapping".  

- Network adapter on the physical computer - pravděpodobně nejzajímavější 

řešení. Pomocí fyzické síťové karty hostitelského počítače se virtuální počítač připojí 

do fyzické sítě a bude se jí jevit jako další připojený počítač se vším všudy. [14] 

Při použití poslední možnosti je nutné si uvědomit několik věcí: 

- Síťová konfigurace virtuálního počítače bude podobná, jako konfigurace 

hostitelského. Pokud v síti běží DHCP, přidělí mu dynamicky adresu. Pokud v síti 

funguje statické přidělování adres, je nutné počítači takovou přidělit a nastavit. 

- Vzhledem ke způsobu připojení je jakýkoliv softwarový firewall běžící na 

hostitelském stroji vůči virtuálnímu počítači neúčinný. Z hlediska zabezpečení je tedy 

nutno k virtuálnímu stroji přistupovat jako k fyzickému.  

- Pokud přenášíte virtuální počítače mezi fyzickými, zkontrolujte si po přenosu 

nastavení této hodnoty, protože nastavení je vázáno na název síťové karty (který 

bude pravděpodobně odlišný). [14] 

Pokud do okna virtuálního počítače klepnete myší, zůstane myš "zachycena" v okně a není 

možné dostat se ven. K uvolnění kurzoru se musí stisknout naprázdno pravý Alt (označen 

jako Alt Gr). Alt Gr je ve virtuálním počítači velmi důležitá klávesa. Obecně se jí říká host 

key a v nastavení jde změnit. Používá se k různým "systémovým" účelům. Nejpoužívanější 

klávesové zkratky jsou: 

- Alt Gr+Del - pošle do virtuálního počítače CTRL+ALT+DEL 

- Alt Gr+Enter - přepíná mezi celoobrazovkovým režimem a během v okně 
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- Alt Gr+P - zastaví (pause) a pak zase rozběhne (resume) virtuální stroj  

- Alt Gr+R - vyresetuje virtuální stroj  

5.5 Virtual machine Additions 

Virtual Machine Additions je balík software, který se instaluje do virtuálního počítače. 

Pokud je nainstalován, výrazně se tím zvýší výkon virtuálního počítače a komfort práce  

s ním. Virtual Machine Additions je v podstatě stejný jako sada VMware Tools u produktu 

VMware Workstation. 

Virtual Machine Additions jsou dostupné pro následující operační systémy: 

- Microsoft Windows 95, 98, NT, Me, 2000, XP, 2003 

- MS-DOS  

- OS/2 

- Microsoft Windows Vista - provoz Microsoft Windows Vista pod Virtual PC je 

spojen s řadou problémů 

- RedHat a SuSE Linux 

Kromě neviditelných "systémových" vylepšení získá Virtual PC instalací Virtual Machine 

Additions následující výhody: 

- Standardní chování kurzoru myší (nezachytává se). 

- Sdílení schránky (přenos dat mezi hostitelským a hostujícím systémem přes 

schránku).  

- Mapování adresářů (sekce Shared Folders v Settings umožní namapovat adresář  

z hostitelského operačního systému jako síťový disk v hostujícím systému).  

- Dynamická změna rozlišení (změnou velikosti okna měníte rozlišení v hostujícím 

systému).  

- Drag and drop přenos souborů (přetahováním můžete přenášet soubory mezi 

hostujícím a hostitelským systémem). [14] 
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6 POROVNÁNÍ PRODUKTŮ VIRTUALIZACE 

Vzhledem k současné nabídce virtualizačních nástrojů, budou v následující kapitole 

porovnány produkty VMware Player, VMware Server, VMware Workstation a Microsoft 

Virtual PC 2007.  

Všechny tyto produkty jsou vhodné pro výuku předmětu Operační systémy na UTB Zlín.  

VMware Player je odlehčenou verzi VMware Workstation. Oproti VMware Workstation 

neobsahuje možnost vytváření nových virtuálních strojů a možnost editace vlastností 

virtuálního stroje. Nemožnost editace je možné nahradit např. ruční editací konfiguračního 

souboru virtuálního stroje. Největší výhodou produktu je, že je zdarma. 

VMware Server je virtualizační nástroj, určený zejména pro virtualizaci serverů. Jeho hlavní 

výhodou je, že server může běžet na pozadí a jeho správa může probíhat buď pomocí 

lokální nebo síťové klientské aplikace. Další výhodou je, že je zdarma.  

VMware Workstation je profesionální virtualizační nástroj, určený zejména pro vývoj  

a testování aplikací. Disponuje možností vytvářet a editovat virtuální stroje. VMware 

Workstation umožňuje import virtuálních strojů, vytvořených v aplikaci MS Virtual PC. 

Jeho velkou nevýhodou je poměrně vysoká cena.  

Microsoft Virtual PC 2007 je jednodušší virtualizační nástroj. Oproti VMware Workstation 

neposkytuje tak široké možnosti nastavení a nepodporuje takové množství operačních 

systémů. Jedinými podporovanými jsou systémy společnosti Microsoft a RedHat a SuSE 

Linux. Jeho nevýhodou je omezený výběr hostitelských operačních systémů. Výhodou 

produktu MS Virtual PC je, že je zdarma.  

Z hlediska ceny je pro výuku nejvýhodnější VMware Player, VMware Server nebo MS 

Virtual PC. Z hlediska použitelných funkcí je nejvhodnější VMware Workstation nebo 

VMware Server. Avšak z hlediska výkonu je nejvhodnějším produktem VMware Player.   
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II. PRAKTICKÁ ČÁST 
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7 INSTALACE HOSTUJÍCÍCH OPERAČNÍCH SYSTÉMŮ 

Vzhledem k probíraným operačním systémům na výuce předmětu Operační systémy byly 

pro instalaci do virtuálního stroje zvoleny následující operační systémy: 

- Microsoft Windows XP 

- Slackware Linux 11.0 

- MS-DOS 6.22 

Návody k instalaci jednotlivých systémů jsou uvedeny v přílohách P II, P III a P IV. 
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8 KONFIGURACE OPERAČNÍHO SYSTÉMU SLACKWARE 

LINUXU 

Veškerá konfigurace systému byla provedena pod uživatelem root. 

Pomocí příkazu adduser student byl vytvořen nový účet student. Vytvořený uživatel 

student byl zařazen do skupiny users.  

Protože ve výuce Operačních systémů je nutné, aby uživatel student mohl připojovat  

a odpojovat CD-ROM mechaniku, bylo potřeba v souboru /etc/fstab na řádku 

/dev/cdrom doplnit v 3. sloupci položku users. 

Na žádost vedoucího práce byla zrušena kontrola svazku. Toto nastavení bylo provedeno 

změnou hodnoty 1, v souboru /etc/fstab na řádku /dev/hda2 v posledním sloupci,  na 

hodnotu 0. 

Pro usnadnění práce se systémem Slackware Linux bylo provedeno nastavení zapnutí 

numerické klávesnice při startu systému. Aby se numerická klávesnice zapnula při startu 

systému, bylo nutné provést zápis následujícího skriptu: 

INITTY=/dev/tty[1-6] 
for tty in $INITTY; do 
setleds -D +num < $tty 
done 

do souboru /etc/rc.d/rc.local . 

Pro podrobnější zobrazení obsahu adresáře a pro požádání o potvrzení při mazaní souboru 

byly do souboru ~/.profile zapsány následující příkazy: 

alias ls=’ls -l’ 
alias rm=’rm -i’ 

Na žádost vedoucího byl změněn HOSTNAME. Změna byla provedena přepsáním názvu 

darkstar.example.net na opsys.utb v souboru /etc/HOSTNAME.  

Pro zmenšení rozlišení byla provedena změna v souboru /etc/lilo.conf. 

Neokomentovaný řádek, označující, které rozlišení má být nastaveno, byl okomentován 

pomocí znaku #. Jako nové rozlišení bylo zvoleno 800x600x256, smazáním znaku # v řádku 

vga=771.  

Pro automatické vypnutí po ukončení systému Slackware Linux bylo nutné provést zápis 

příkazu modprobe apm do souboru /etc/rc.d/rc.local. 
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Pro studenty, kterým nevyhovuje čtení anglické manuálové dokumentace Slackware Linux, 

byl vytvořen návod pro počeštění a instalaci české manuálové dokumentace Slackware 

Linux. Návod na počeštění a instalaci je uveden v příloze P VI.  
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ZÁVĚR 

Hlavním cílem této bakalářská práce bylo připravit diskové obrazy operačních systémů pro 

výuku  předmětu Operační systémy. K vytvoření a nastavení virtuálních strojů byl použit 

produkt VMware Workstation verze 5.5. K instalaci hostujících systémů do virtuálního 

stroje byly zvoleny systémy: MS-DOS 6.22, Microsoft Windows XP a Slackware Linux 

11.0. 

Pro výuku Operačních systémů by bylo mnohem lepší zvolit Microsoft Windows Vista, aby 

se studenti mohli lépe seznámit s novým systémem od společnosti Microsoft. Avšak 

vzhledem k vybavenosti počítačových učeben na UTB je použití tohoto systému obtížně 

realizovatelné.  

Porovnáním produktů virtualizace bylo zjištěno, že z hlediska použitelných funkcí by 

nejvhodnějšími produkty k provozování virtuálního stroje ve výuce byly VMware 

Workstation a VMware Server. Jelikož VMware Server je šířen zdarma, doporučila bych 

právě tento produkt. A to i za předpokladu, že je určen spíše pro provoz serverů a je 

výkonově pomalejší.  

Po nainstalování a nastavení systému Slackware Linux bylo nutné provést kontrolu 

funkčnosti příkladů příkazů uvedených ve skriptech. Po vyzkoušení bylo zjištěno, že 

veškeré příklady fungují až na příkaz  rm /tmp/* | at 3:00•. Nefunkčnost tohoto 

příkazu byla způsobena nepřítomností příkazu echo. Program at totiž očekává příkaz na 

vstupu (stdin) Ukázky testovacích příkladů jsou uvedeny v příloze P VII.  

 

 

                                                

 

• funkční příkaz je: echo rm /tmp/* | at 3:00 
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ZÁVĚR V ANGLIČTINĚ 

The main aim of this bechelor thesis was to make disk images of operating systems for the 

education of the subject Operating systems. The product VMware Worstation 5.5 was used 

for creating and configurating virtual machines. The systems MS-DOS 6.22, Microsoft 

Windows XP and Slackware Linux 11.0 were chosen for installing host systems into the 

virtual machine. 

For the education of Operating systems is better to choose Microsoft Windows Vista. The 

students could be better informed about the new system from Microsoft. Because the 

computer classrooms at UTB are not well equipped, usage of Microsoft Windows Vista 

system is hardly possible.. 

The products of virtualisation were compared. VMware Workstation and VMware Server 

are more suitable for operation of virtual machine in education. However, VMware Server is 

the most suitable product, because it is free. 

During the installation and configuration of the Slackware Linux system I checked 

instructions from the university publication. Only the instruction rm /tmp/* | at 
3:00 didn't function, because the program expects an input instruction (stdin). Test 

instructions are listed in the insertion P VII. 
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PŘÍLOHA P I: NÁVOD NA INSTALACI VMWARE WORKSTATION 

1. Přihlašte se na váš systém jako administrátor nebo jako uživatel, který je členem 

skupiny Administrators. 

Poznámka: Pokud instalujete VMware na Microsoft Windows XP nebo Windows 

Server 2003 musíte se přihlásit jako lokální administrátor (nepřihlašujte se do 

domény, ledaže by váš účet v doméně byl ve skupině místních administrátorů). 

Ačkoliv pouze administrátor může provést instalaci VMware na Microsoft Windows 

XP nebo Windows Server 2003, normální uživatel (bez administrátorských práv) 

může tento  program spustit po jeho nainstalovaní. 

Poznámka: Každý uživatel potřebuje jednu licenci. 

2. Jestliže instalujete z CD, vyberte v menu Start položku Spustit a zadejte cestu  

k instalačnímu souboru setup.exe nacházející se na vloženém CD. 

Jestliže instalujete ze staženého souboru, vyberte v menu Start položku Spustit, 

pomocí položky Procházet vyhledejte adresář, ve kterém je uložen stažený 

instalační soubor a spusťte instalaci. (Jméno souboru je podobné názvu 

VmwareWorkstation-<xxxx>.exe, kde <xxxx> je sériové číslo reprezentující verzi 

programu.) 

3. Pro opuštění uvítacího dialogu klikněte na položku Next (Další). 

4. Přečtěte si licenční smlouvu. Pokud chcete pokračovat v instalaci musíte souhlasit  

s podmínkami licenční smlouvy a zvolit položku Next (Další). 

5. Dále vyberte adresář, do kterého bude VMware Workstation nainstalován. 

Chcete-li instalovat do jiného adresáře než výchozího, klikněte na položku Change 

(Změnít) a adresář vyhledejte. Jestliže adresář neexistuje, instalátor jej pro vás 

vytvoří. 

Klikněte na položku Next (Další). 

Varování: Neinstalujte VMware Workstation na síťový disk. 



 

 

Poznámka: Microsoft Windows a Microsoft Installer omezují délku cesty složky na 

místním disku na 255 znaků. Jestliže cesta ke složce překročí tento limit, objeví se 

chybová zpráva. Musíte vybrat nebo uvést cestu kratší. 

6. Vyberte místo, na které chcete při instalaci vytvořit zástupce. Pokud nechcete 

vytvořit zástupce zrušte všechny volby. 

Výběr obsahuje Desktop (pracovní plochu), Start Menu Programs folder 

(nabídka Start – složka Programy) a Quick Launch toolbar (panel nástrojů – 

snadné spuštění). 

7. V systémech Microsoft Windows se používá funkce AutoRun, umožňující 

automatické spuštění programů ihned po vložení CD či DVD média do mechaniky. 

A protože tato funkce může mít závažný vliv na používání těchto mechanik  

v běžících virtuálních strojích, zeptá se vás, zda nechcete tuto funkci vypnout. 

8. Poté Instalátor nahromadí potřebné informace a je přípraven začít instalovat 

software. 

Pokud chcete změnit některé nastavení, nyní je čas provést tyto změny.  

Klikejte na položku Back (Zpět) dokud nenarazíte na dialog obsahující informaci, 

kterou chcete změnit. 

Pokud nepotřebujete provést změny, klikněte na položku Install. Instalátor začne 

kopírovat soubory do vašeho počítače.  

9. Doplňte vaše jméno, jméno společnosti a sériové číslo a poté klikněte na položku 

Next (Další). 

Poznámka: Jestliže tento krok přeskočíte, musíte zadat vaše sériové číslo později,  

a to před spuštěním virtuálního počítače. 

10. Pro dokončení instalace klikněte na položku Finish (Dokončení). 

VMware Workstation software je nainstalován. 

Poznámka: Některé instalace vyžadují po ukončení restartování počítače, čímž 

docílíte korektní instalace VMware Workstation. 

 



 

 

  

  

  

  



 

 

PŘÍLOHA P II: NÁVOD NA INSTALACI MICROSOFT WINDOWS 

XP 

1. Vložte instalační CD Microsoft Windows XP do mechaniky. 

Poznámka: Chcete-li provést instalaci z obrazu instalačního CD, postupujte takto: 

- otevřete si nastavení virtuálního stroje (VM > Settings) a vyberte tu mechaniku,  

z které chcete instalaci provést 

- vyberte použít ISO obraz (Use ISO Image) a následně pomocí položky Browser 

(Procházet) vyhledejte adresář, ve kterém je uložen obraz instalačního CD 

- klikněte na OK, uložte konfiguraci a zavřete nastavení virtuálního stroje 

2. Zapněte virtuální stroj a začněte s instalací Microsoft Windows XP. 

3. Následující kroky jsou stejné, jako instalace reálného počítače. 

4. Před samotnou instalací načítá instalační program soubory, potřebné k instalaci.  

5. Nyní musíte zadat, kterou činnost chcete provést:  

- spustit instalaci (Enter), 

- opravit systém (klávesa R) 

- ukončit instalační program (klávesa F3) 

6. Pro pokračování instalace musíte souhlasit s licenční smlouvou systému Microsoft 

Windows XP. Tedy stisknout klávesu F8 nebo instalaci ukončit klávesou ESC. 

7. Zobrazí se vám tabulka s existujícími oddíly a místem, které jsou k dispozici pro 

vytvoření nového oddílu. Poté musíte opět zadat, kterou činnost chcete provést:  

- pokračovat v instalaci systému (Enter) 

- vytvořit nový oddíl (klávesa C) 

- vybraný oddíl odstranit (klávesa D) 

Poznámka: Pokud zvolíte vytvořit nový oddíl, budete požádáni o určení velikosti 

nového oddílu a poté o jeho potvrzení. 

8. Pokud není oddíl naformátovaný, musíte zadat systém souborů, kterým jej chcete 

zformátovat a stisknout klávesu Enter. 



 

 

9. Poté budou vytvořené oddíly naformátovány. 

10. Dále instalační program začne kopírovat soubory do instalační složky. 

11. Po restartování virtuálního počítače se spustí instalace Microsoft Windows XP. 

12. Následně vás instalační program požádá o místní a jazykové nastavení (nastavení 

způsobu zobrazení čísel, měny, data a času). Pro pokračování stiskněte tlačítko Next 

(Další). 

Poznámka: Chcete-li si nastavení prohlédnout nebo dokonce změnit, klepněte na 

tlačítko Vlastní nebo Podrobnosti. 

13. Doplňte jméno a název společnosti či organizace a pokračujte stisknutím tlačítka 

Next (Další). 

14. Zadejte 25-ti místné sériové číslo a stiskněte Next (Další). 

Upozornění: Jestliže zadáte sériové číslo špatně, budete požádání o opětovné 

zadání. 

15. Doplňte název počítače a přihlašovací heslo pro správce systému. 

16. Nyní se začne instalovat síť, položky nabídky Start, registrovat součásti, ukládat 

nastavení a nakonec dojde k odstranění použitých dočasných souborů. 

17. Po úspěšné instalaci systému dojde k restartování virtuálního stroje a následného 

spuštění systému Microsoft Windows XP. 

  



 

 

  

  

  

  



 

 

PŘÍLOHA P III: NÁVOD NA INSTALACI SLACKWARE LINUX 11.0 

1. Vložte instalační CD Slackware Linux do mechaniky. 

Poznámka: Chcete-li provést instalaci z obrazu instalačního CD, postupujte takto: 

- otevřete si nastavení virtuálního stroje (VM > Settings) a vyberte tu mechaniku,  

z které chcete instalaci provést 

- vyberte použít ISO obraz (Use ISO Image) a následně pomocí položky Browser 

(Procházet) vyhledejte adresář, ve kterém je uložen obraz instalačního CD 

- klikněte na OK, uložte konfiguraci a zavřete nastavení virtuálního stroje 

2. Zapněte virtuální stroj a začněte instalovat Slackware Linux. 

3. Následující kroky jsou stejné, jako instalace reálného počítače. 

4. Nejprve musíte zadat, kterou činnost chcete provést: 

- spustit instalaci (Enter) 

- změnit variantu jádra systému (F2) – výchozí jádro sata.i 

5. Pro výběr mapy rozložení klávesnice stiskněte klávesu 1 a potvrďte klávesou Enter. 

6. Vyberte mapu rozložení klávesnice. 

Poznámka: Pro výběr používejte šipek a výběr potvrďte klávesou Enter. Jako 

výchozí rozložení je zvoleno us.map (anglická klávesnice). Pokud si nevíte  

s výběrem rady, zvolte qwerty/cz-lat2.map. 

7. Nyní můžete vyzkoušet, zda-li vám zvolené rozložení klávesnice vyhovuje. Pokud 

vám rozložení vyhovuje, vepište do řádku 1 a potvrďte, pokud nevyhovuje, 

rozložení klávesnice změníte vepsáním 2. 

8. Přihlašte se jako root. 

9. Zadejte činnost, kterou chcete nyní provést: 

- rozdělit disk, použijte příkaz cfdisk nebo fdisk + název disku, který chcete 

rozdělit (např. fdisk /dev/hda). 

- začít instalaci, použijte příkaz setup. 

10. Jestliže nechcete rozdělit disk přeskočte na krok 19) 



 

 

Poznámka: Pro popis rozdělení disku jsem zvolila příkazu fdisk. 

11. Pro zobrazení nápovědy zvolte písmeno m. 

12. Pro vytvoření nového oddílu zvolte písmeno n. 

13. Zvolte činnost, kterou chcete provést: 

- prodloužit oddíl (e) 

- vytvořit primární oddíl (p) 

Poznámka: V našem případě musíte zvolit písmeno p. 

14. Zvolte číslo oddílu. 

15. Zvolte první cylinder oddílu.  

Poznámka: Pokud je tento oddíl první, je jako výchozí zvolený 1. 

16. Zvolte poslední cylinder oddílu nebo velikost oddílu. Velikost můžete volit v MB 

(za číslem napište M) nebo v KB (za číslem napište K). 

17. Nyní je oddíl vytvořen. U oddílu můžete provést i další úpravy: 

- vypsat seznam typu oddílů (písmeno l) 

- změnit systém oddílu (písmeno t) 

- smazat oddíl (písmeno d) 

- vytvořit další oddíl (písmeno n) 

- vypsat tabulku oddílů (písmeno p) a další. 

18. Pokud chcete opustit program a zvolené změny neukládat, zvolte písmeno q, pokud 

ovšem chcete změny uložit, zadejte písmeno w. 

19. Nyní přikročíme k instalaci, napište příkaz setup. 

20. Program Setup má v sobě několik částí. Některé z nich musíte před instalací 

nastavit. 

• HELP (nápověda) 

• KEYMAP (změna mapy rozložení klávesnice) 

• ADDSWAP (aktivováni swapování oddílu) 



 

 

• TARGET (cílový oddíl instalace) 

- zvolte oddíl, na který chcete instalovat systém 

- poté by jste měli tento oddíl zformátovat. Na výběr máte tyto následující 

možnosti: 

- Format – rychlé formátování bez kontroly špatných bloků 

- Check – formátování s kontrolou špatných bloků 

- No – neformátovat 

- zvolte souborový systém (ext2, ext3 a reiserfs) 

- po zformátování oddílu se vás program zeptá, zda-li má tento oddíl přidat do 

souboru /etc/fstab. Tento dialog potvrďte. 

• SOURCE (zdroj instalačních balíčků) 

- vyberte zdroj, ze kterého budete instalaci provádět (z CD/DVD, pevného 

disku, sítě nebo adresáře) 

- zvolíte-li instalaci z CD/DVD, je třeba zadat cestu k mechanice. Pokud si 

nejste jisti jakou cestu zadat, zvolte auto, program si ji najde sám 

• SELECT (výběr balíčků k instalaci) – vyberte ty balíčky, které se mají 

nainstalovat 

Poznámka: Výběr balíčků provádějte pomocí šipek a mezerníku. Konečný 

výběr potvrďte klávesou Enter. 

• INSTALL (instalace systému) – zvolte režim výběru balíčků (full, expert, 

menu, newable, custom, tagpath, help). Pokud si chcete sami vybrat 

jednotlivé baličky, zvolte menu. 

- poté si volíte jednotlivé balíčky, které budete chtít nainstalovat. Jednotlivé 

balíčky jsou rozděleny do částí, které jste si vybrali v části SELECT.   

21. Program Setup začne instalovat balíčky. 

22. Vyberte místo, z kterého chcete instalovat jádro systému (bootdisk, cdrom, floppy 

nebo skip – přeskočit). 



 

 

23. Vyberte jádro systému. Nejčastěji volené jádro bývá bare.i nebo sata.i. 

24. Vyberte instalaci zavaděče LILO (simple, expert, skip). 

25. Zvolte nastavení myši.  

26. Pokud chcete, aby se program GPM (určený pro práci s myší v konzoli) načetl při 

bootování systému, odpovězte Yes (Ano). 

27. Vyberte služby, které se mají spustit při bootování systému.  

Poznámka: Výběr proveďte pomocí šipek a mezerníků. Zvolené služby potvrďte 

klávesou Enter. 

28. Nastavení časového pásma hardwarových hodin: 

- GMT (zvolte Yes) 

- lokální čas (zvolte No) 

29. Zvolte nastavení časového pásma (v našem případě Europe/Prague). 

30. Jestliže nemáte vytvořené heslo pro roota, program vás na to upozorní. Proto je 

lepši jej vytvořit. Pro vytvoření hesla zvolte Yes.  

31. Pokud vytváříte heslo, zadejte heslo, které musí mít 5 až 127 znaků a stiskněte 

klávesu Enter. Poté jej musíte zadat znovu a opět stisknout klávesu Enter. 

32. Nakonec musíte systém restartovat (např. příkazem reboot). Po restartování 

dojde k načtení systému Slackware Linux. 

  



 

 

  

  

  

  



 

 

PŘÍLOHA P IV: NÁVOD NA INSTALACI MS-DOS 

1. Vložte instalační disketu MS-DOS do mechaniky. 

Poznámka: Máte-li obrazy instalačních disket uložené na vašem disku, postupujte 

takto: 

- otevřete si nastavení virtuálního stroje (VM > Settings), a vyberte disketovou 

mechaniku 

- pokud disketovou mechaniku nemáte mezi hardwarem virtuálního stroje, je 

potřeba ji vytvořit, stiskněte proto tlačítko Add (Přidat), otevře se vám průvodce 

přidáním hardwaru. Pro pokračování stiskněte tlačítko Next (Další) 

- vyberte typ hardwaru, který potřebujete, v našem případě Floppy Drive a stiskněte 

tlačítko Next (Další) 

- vyberte, o jaký typ disketové mechaniky máte zájem: použít fyzickou disketovou 

mechaniku, použít obraz diskety (což je náš případ) a nebo vytvořit prázdný obraz 

diskety. Dále stiskněte tlačítko Next (Další). 

- pomocí tlačítka Browse (Procházet) vyhledejte adresář, ve kterém se nachází 

obraz instalační diskety a klikněte na Open (Otevřit) 

- klikněte na tlačítko Finish (Dokončit), uložte konfiguraci a zavřete nastavení 

virtuálního stroje 

2. Zapněte virtuální stroj a začněte s instalací MS-DOS. 

3. Následující kroky jsou stejné, jako instalace na reálném počítači. 

4. Před samotnou instalací instalační program kontroluje vaši konfiguraci systému. 

5. Nyní musíte zadat, kterou činnost chcete provést: 

- spustit instalaci (Enter) 

- nápovědu (F1) 

- ukončit instalaci (F3) 

- změnit barvu zobrazení (F5) 



 

 

6. Nyní musíte nastavit datum, čas, zemi a rozložení klávesnice. Nastavení měníte 

pomocí šipek a potvrzujete stisknutím klávesy Enter. Pro skončení nastavení musíte 

jít na položku The settings are correct a stisknout klávesu Enter. 

7. Vepište adresář, do kterého má instalační program umístit soubory systému  

MS-DOSu. 

8. Instalační program nyní musí vytvořit oddíl na volném místě na disku. Pokud 

souhlasíte, musíte na řádku Configure unallocated disk space stisknout klávesu 

Enter, pokud ne, program ukončíte klávesou F3. 

9. Po restartování virtuálního stroje se znovu zkontroluje vaše konfigurace systému. 

10. Instalační program nyní začne instalovat systém. 

11. Poté jste vyzváni k vložení další instalační diskety a stisknutí klávesy Enter. 

12. Po chvilce instalování musíte opět vložit další instalační disketu a stisknout klávesu 

Enter. 

13. Po skončení instalace vyjměte disketu z disketové mechaniky a stiskněte klávesu 

Enter. 

14. Poté dojde k restartování virtuálního stroje a následného spuštění systému MS-DOS. 
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PŘÍLOHA P V: NÁVOD NA POUŽITÍ VMWARE WORKSTATION 

1) Popis okna VMware Workstation 

VMware Workstation virtuální stroj je jako samostatný počítač, který běží v okně vašeho 

fyzického počítače. 

Okno Workstation je rozděleno do tři části, viz obrázek 2: 

- The Home Page, Summary View, Console View (Hlavní stránka, souhrnné 

zobrazení a konzolový pohled) – na pravé straně okna, jedná se o hlavní část okna, 

na kterém naleznete vaše virtuální stroje 

- The Toolbar (Panel nástrojů) – na vrchní části okna, tlačítka, která se zde nachází, 

jsou určena pro práci s virtuálním strojem (stop, pauza, start, restart, oblíbené, 

celoobrazovkový režim atd.) 

- The Favorites List (Seznam oblíbených) – na levé části okna, zde se nachází záložky 

vašich virtuálních strojů umožňující rychlejší přístup 

 



 

 

The Home Page, Summary View, Console View (Hlavní stránka, souhrnné zobrazení a 

konzolový pohled) 

The Home Page (Zobrazení hlavní stránky) 

Zobrazit hlavní stránku můžete vybráním Home panelu v hlavní části okna. Tady naleznete 

ikony určené k vytvoření nového nebo otevření existujícího virtuálního stroje. 

Hlavní stránku můžete zavřít kliknutím na tlačítko X, nacházející se na pravé straně panelu. 

Pro opětovné zobrazení je nutné vybrat View > Go to Home Tab. 

The Summary View (Souhrnné zobrazení) 

Vybráním tohoto zobrazení nám Workstation zobrazí konfiguraci vybraného hostujícího 

systému.  

Poznámka: Souhrnné zobrazení umožňuje zobrazení jen těch virtuálních strojů, které jsou 

aktuálně otevřené. Otevřít virtuální stroj můžete vybráním položky File > Open, dále 

vyberte soubor s příponou .vmx a stiskněte tlačítko Open (Otevřít). 

The Console View (Konzolový pohled) 

Toto zobrazení je možné použít jen tehdy, máte-li nějaký virtuální stroj spuštěný, z čehož 

vyplývá, že konzolový pohled nám zobrazuje běžící hostující systém. 

The Toolbar (Panel nástrojů) 

Panel nástrojů obsahuje tlačítka, jimiž můžete své virtuální stroje zapínat, vypínat nebo 

změnit zobrazení programu. 

Power Off 

Toto tlačítko vypíná aktivní virtuální stroj. Ve Workstation je možné jej nastavit jako: 

- „měkké“ vypnutí (zvané shut down), vyšle virtuální stanici signál pro vypnutí 

(podobně jako u ATX zdroje) 

- „tvrdé“ vypnutí (zvané power off), stejné jako vypnutí fyzického počítače pomocí 

hlavního vypínače Power. 



 

 

Suspend 

Toto tlačítko zastaví virtuální stroj. Je podobné režimu spánku u fyzického počítače. Po 

zapnutí je obnovena vaše poslední práce, jako by jste ji neopustili. 

Power On and Resume 

Toto tlačítko zapíná vybraný virtuální stroj nebo jej obnoví z režimu spánku. 

Reset 

Toto tlačítko restartuje virtuální stroj. Je stejné jako restartování fyzického počítače pomocí 

tlačítka Reset. 

Snapshot 

Toto tlačítko umožňuje uložit aktuální stav virtuálního stroje jako by jste ukládali dokument  

v textovém editoru. Můžete se k němu později vrátit pomocí tlačítka Revert. 

Revert 

Toto tlačítko umožňuje vrátit se k původnímu stavu virtuálního stroje, uchovaného 

tlačítkem Snapshot. 

Manage Snapshots 

Toto tlačítko otevírá správce snímků, který zobrazuje existující, vytváří nové nebo kopíruje 

stávající snímky virtuálních strojů.  

Fullscreen 

Toto tlačítko umožňuje zvětšit zobrazení virtuálního stroje přes celou obrazovku. Virtuální 

stroj tedy není zobrazen v okně. 

Poznámka: Stisknutím tlačítka Ctrl+Alt obnovíte zobrazení okna Workstation. 

Quick Switch 

Toto tlačítko zobrazí virtuální stroj přes celou obrazovku.  



 

 

Poznámka: Tento režim nezobrazuje menu a panel nástrojů. Pro jeho opětovné zobrazení 

je nutné stisknout opět tlačítko Quick Switch, které se objeví najetím myši na horní okraj 

obrazovky. 

Summary 

Toto tlačítko zobrazí souhrnné zobrazení. Více informací naleznete v části The Summary 

View. 

Console 

Toto tlačítko zobrazí konzolový pohled. Více informací naleznete v části The Console 

View. 

Customizing the Toolbar 

Umožňuje změnit panel nástrojů (přidat, odebrat nebo změnit pořadí tlačítek). Panel 

nástrojů je rozdělen do tří částí: tlačítka pro práci s virtuálními stroji (Power), tlačítka pro 

práci se snímky virtuálních strojů (Snapshot) a tlačítka režimů zobrazení (View).  

Přidat či odebrat tlačítka panelu nástrojů: 

- klikněte pravým tlačítkem myši na panel nástrojů 

- vyberte tu část tlačítek, kterou chcete zobrazit 

Přizpůsobit panel nástrojů 

- klikněte pravým tlačítkem myši na panel nástrojů a vyberte Customize  

(Přizpůsobit). 

- pro přidání nebo odebrání musíte vybrat tlačítko, s kterým chcete pracovat  

a stisknout tlačítko Add nebo Remove (Přidat nebo Odebrat). Pro změnu pořadí, 

vyberte tlačítko, u kterého chcete změnu provést a stiskněte tlačítko Move Up nebo 

Move Down (Nahoru nebo Dolů). Změna tlačítek se zobrazuje automaticky na 

panelu nástrojů. 

- klikněte na tlačítko Close (Zavřít). 



 

 

Seznam oblíbených (The Favorites List) 

- rychlý přístup – podobně jako záložky ve webovém prohlížeči, napomáhá  

k rychlému přístupu k virtuálním strojům, umožňuje uspořádat, přidávat, seskupovat 

nebo mazat složky. Dále umožňuje otevírat virtuální stroje, aniž by jste museli 

vyhledávat soubory na hostitelském systému. 

- stav – seznam oblíbených zobrazují stav virtuálních strojů pomocí různých ikon. 

Tyto ikony ukazují, které virtuální stroje jsou vypnuté, zapnuté, které v režimu 

spánku, nebo které virtuální stroje jsou kopiemi virtuálních strojů.  

- příkazy – kliknutím pravého tlačítka na ikony v seznamu se zobrazí menu s příkazy, 

které můžete použít pro virtuální stroje. Menu umožňuje vytváření nových 

virtuálních strojů, dále otevírat existující virtuální stroje nebo obrazy systémů, 

vytvořených v Microsoft Virtual PC nebo Virtual Server atd. 

Přidání položky do seznamu oblíbených 

- vyberte File > Open a vyhledejte místo, ve kterém se nachází stanice (.vmx), 

kterou si chcete dát do oblíbených. Otevře se vám nový panel s vybraným virtuálním 

strojem. 

- klikněte pravým tlačítkem na panel tohoto stroje a vyberte Add to Favorites 

Virtuální stroj se objeví v seznamu oblíbených. 

Odstranění položky ze seznamu oblíbených 

- vyberte virtuální stroj ze seznamu 

- klikněte pravým tlačítkem myší a vyberte Remove from Favorites 

Virtuální stroj se smaže ze seznamu oblíbených. 

Změna názvu položky v seznamu oblíbených 

- pravým tlačítkem myší klikněte na položku, kterou chcete přejmenovat 

- vyberte Rename 

- vepište nový název a stiskněte Enter 



 

 

Poznámka: Změní se pouze zobrazovaný název, nikoliv soubor hostitelského systému. 

Zařazení oblíbených do složek 

- klikněte pravým tlačítkem myší v seznamu oblíbených 

- vyberte New > Folder a stiskněte Ester 

- vepište název složky a zvolte OK 

- nyní zbývá přesunout položky seznamu do nové složky, např. přetažením položky 

myší 

Zobrazení nebo skrytí seznamu oblíbených 

- vyberte View > Favorites 

Jestliže seznam byl vidět, zmizel. Jestliže byl skrytý, objeví se. 

2) Nastavení předvoleb VMware Workstation (Preferences) 

Dialog předvoleb umožňuje změnit množství nastavení, které aplikuje VMware Workstarion 

na sebe bez ohledu na běžící virtuální stroj. 

Pro změnu tohoto nastavení zvolte Edit > Preferences. 

Workspace 

V panelu Workspace můžete změnit adresář, ve kterém jsou nově vytvořené virtuální stroje 

ukládány. Používaný výchozí adresář je zobrazen pod textem Default location for virtual 

machines and teams. Pro změnu klikněte na Browse (Hledat) a vyhledejte adresář, který 

chcete používat. Nyní každý nově vytvořený virtuální stroj, bude uložen v podadresáři 

zvoleného adresáře. 

Jestliže zatrhnete Remember opened tabs between sessions, zobrazí se, po otevření 

Workstation, ty virtuální stroje, které byly otevřené. Za otevřené virtuální stroje jsou 

považovány ty, které splňují obě následující pravidla: 

- virtuální stroj byl načtený 

- virtuální stroj byl zapnutý, vypnutý nebo v úsporném režimu 



 

 

V sekci Software updates naleznete nastavení kontroly aktualizací. Pokud chcete, aby 

kontrola probíhala automaticky v určitém intervalu, postupujte takto: 

- jestliže nejste v panelu Workspace, vyberte položku Edit > Preferences  

> Workspace 

- u položky Check for updates zvolte interval kontroly (Never - nikdy,  

Daily - denně, Weekly - týdně, Monthly - měsíčně) 

Dále zde naleznete informace o času a výsledku nedávné kontroly aktualizace a čas další 

naplánované kontroly. 

Poznámka: Kontrolovat aktualizaci můžete pokud jste připojení k internetu. 

Input 

Zajišťuje ovládání klávesnice a myši virtuálního stroje.  

Volby Grab keyboard and mouse input on mouse click a Grab keyboard and mouse 

input on key press mají vliv na vstupní fokus – VMware převezme řízení klávesnice či 

myši, jakmile něco napíšete v okně virtuálního stroje či jakmile v tomto okně klepnete na 

myš.  

Poznámka: VMware nepředá virtuálního stroji první klepnutí na myš, avšak předá první 

stisknutou klávesu. 

Následující volby jsou výhodné zejména tehdy, máte-li nainstalovanou sadu nástrojů 

VMware Tools. Některé volby dokonce bez těchto nástrojů vůbec nefungují, jiné vám bez 

nich práci spíše zkomplikují než ulehčují. 

Ungrab when cursor leaves windows. Zaškrtnete-li tuto volbu, pak, jakmile přesunete 

ukazatel myši přes okraj VMware, bude řízení ukazatele předán zpět do hostitelského 

operačního systému. Bez nástrojů VMware Tools musíte ukazatele myši uvolnit klávesovou 

zkratkou Ctrl+Alt. Teprve poté převezme řízení myši hostitelský systém.  

Hide cursor on ungrab. Zaškrtnete-li tuto volbu, pak, jakmile přesunete ukazatel myši přes 

okraj VMware, kurzor se ve virtuálním stroji skryje. 

Grab when cursor enters window. Zvolíte-li tuto volbu, pak, jakmile přesunete ukazatel 

myši do okna virtuálního stroje, VMware Workstation převezme jeho řízení. Popisovanou 



 

 

volbu by jste měli používat pouze tehdy, máte-li zaškrtnutou i volbu Ungrab when cursor 

leaves windows. 

Enable copy and paste to and from virtual machine. Tato volba je velmi užitečná, neboť 

ji můžete využit k bezproblémovému kopírování dat v jednom systému a jejich vkládání do 

systému druhého. Obě funkce se totiž budou chovat jakoby jste pracovali pouze v jednom 

systému. [1]  

Hot Key 

Panel Hot Key vám umožňuje změnit první část klávesových zkratek. Ve VMware začínají 

klávesové zkratky klávesami Ctrl+Alt. Je-li však toto nastavení v konfliktu s uživatelským 

rozhraním hostujícího operačního systému či nějaké aplikace, můžete si tuto kombinaci 

změnit na Ctrl+Shift+Alt či jakoukoliv jinou kombinaci kláves Ctrl, Shift a Alt.  

Display 

Autofit 

- Autofit window – změnou nastavení rozlišení hostujícího systému se zároveň 

přemění i velikost okna aplikace. Toto nastavení je stejné jako nastavení výběrem 

View > Autofit Windows. 

- Autofit guest – změnou velikosti okna aplikace se zároveň změní rozlišení 

hostujícího systému. Toto nastavení je stejné jako nastavení výběrem View  

> Autofit Guest. 

Poznámka: Výběrem Autofit guest se aktivuje i Autofit window. 

Full Screen 

- zvolte Resize host pro změnu hostitelského nastavení rozlišení tak, aby se 

shodovalo s nastavením hostujícího systému, jakmile hostující systém přejde do 

celoobrazovkového režimu.  

- zvolte Resize guest pro změnu hostujícího nastavení rozlišení tak, aby se shodovalo  

s nastavením hostitelského systému, jakmile hostující systém přejde do 

celoobrazovkového režimu. 



 

 

- zvolte Don´t resize, jestliže chcete, aby si hostitelský a hostující systém zachoval 

nastavení, jakmile hostující systém přejde do celoobrazovkového režimu. 

Memory 

- rezervovaná paměť – umožňuje nastavení množství fyzického RAM, které 

použijete pro běh všech virtuálních strojů 

- dodatečná paměť – nastavení, jak by měl systém přidělit VMwaru paměť. Tady je 

možné nastavit: 

- fit all virtual machine memory into reserved host RAM – zvolíte-li tuto volbu, 

všechna paměť virtuálního stroje bude přidělena rezervované RAM paměti hostitele 

- allow some virtual machine memory to be swapped – zvolíte-li tuto možnost, 

pak menší část virtuální paměti bude swapována 

- allow most virtual machine memory to be swapped – zvolíte-li tuto možnost, 

pak větší část virtuální paměti bude swapována 

Priority 

U operačních systému, podporujících zpracování několika úloh najednou, se prioritou určuje 

množství procesorového času, které bude určité aplikaci přiděleno. Za normálních 

podmínek má proces VMware stejnou prioritu jako všechny ostatní běžící procesy.  

V případě hostitelských strojů se systémy Microsoft Windows však máte možnost prioritu 

VMware poněkud upravit.  

Procesům VMware můžete přiřadit určitou prioritu pro případ, že VMware převzalo řízení 

klávesnice a myši (tj. má fokus), jinou prioritu můžete přiřadit pro případ, kdy VMware 

fokus nemá. Můžete využít celkem tři úrovně priority: 

- high – umožňující přiřadit VMware vysokou prioritu 

- normal – při níž jsou procesy VMware rovnocenné s ostatními procesy 

- low – procesům VMware se přiřadí méně procesorového času než ostatním 

aplikacím 



 

 

Změnit nastavení pro jednotlivé virtuální stroje a převýšit tak globální nastavení, můžete 

otevřením virtuálního stroje, který chcete nastavit a vybrat VM > Settings, kliknout na 

panel Options, vybrat Advanced a na pravé straně v seznamu vybrat nastavení, které 

chcete.  

Shapshots 

Jestliže vyberete Take and restore snapshots in the background, můžete pokračovat  

v používání virtuálního stroje dokonce i když Workstation vytváří nebo obnovuje snímky 

virtuálního stroje. 

Lockout 

Výběrem této funkce zajistíte uzamknutí některých činností. Činnosti budete moct používat 

jen v případě, že zadáte správné heslo. Uzamknout můžete pouze tři činnosti a to: 

- vytváření nového virtuálního stroje 

- úpravu konfigurace virtuálního stroje 

- změna nastavení sítě 

3) Nastavení virtuálního stroje (Settings) 

VMware Workstation konfiguruje nově vytvořený virtuální stroj, založený na hostujícím 

operačním systému, který si vyberete pomocí průvodce vytvořením nového virtuálního 

stroje (File > New > Virtual Machine). Jestliže chcete změnit nějaké konfigurační 

nastavení, vytvořené průvodcem, použijte editor nastavení virtuálního stroje  

(VM > Settings). [2] 

Hardware  

Na levé straně karty Hardware můžete vidět aktuální zařízení virtuálního stroje. Pokud na 

některé ze zobrazených zařízení klepnete, zobrazí se v pravé části okna jeho konfigurace. 

Současně najdete v této části okna i volby pro změnu konfigurace. Použitím panelu 

Hardware můžete také přidávat nebo odebírat virtuální zařízení. 



 

 

Memory (Paměť) 

Tady můžete nastavit velikost paměti RAM, přístupné hostujícímu operačnímu systému. 

VMware vám zobrazí aktuální paměť (v MB), využitelnou hostujícím systémem, tuto 

hodnotu můžete upravit šipkami nahoru a dolu, nacházejícími se na pravé straně pole.  

Editor nastavení virtuálního stroje také ukazuje hodnoty doporučené paměti, maximální 

doporučené paměti nebo minimální doporučené paměti hostujícího operačního systému.  

Virtual Disk (Virtuální disk) 

Editor nastavení nám ukazuje kapacitu virtuálního disku. Informuje, jak je disk zaplněný  

a kolik je volného místa.  

Tlačítko Defragment spouští proces defragmentace bloků v souboru virtuálního disku. 

VMware zapisuje každý nový blok na konec virtuálního souboru. Avšak, protože hostující 

operační systém nezapisují bloky dat v tom pořadí, v jakém jsou zobrazovány, po určité 

době provozu hostujícího operačního systému dojde k tomu, že bloky budou zpřeházené. 

Výsledkem může být snížení výkonu. Při defragmentaci virtuálního disku jsou jednotlivé 

bloky uspořádány tak, aby data byla spojitá.  

Jestliže chcete upřesnit uzel zařízení klikněte na Advanced. Tady můžete také upřesnit 

režim disku. Normální disk je zahrnut ve snímcích. Ve většině případů toto nastavení 

chcete. Jestliže zaškrtnete Independent, disk nebude zahrnut ve snímkách. Poté budete 

moct volit z následujících možností: 

- Persistent – změny jsou ihned a nastálo zapsány na disk 

- Nonpersistent – jestliže vypnete nebo vrátíte snímek, změny na disku budou 

vyřazeny 

CD-ROM 

Mechaniky CD-ROM můžete nakonfigurovat jako zařízení IDE či SCSI. Protože  

v prostředí VMware můžete CD-ROM mechaniky odpojovat a znovu připojovat, můžete se 

rozhodnout, že při spuštění VMware bude CD-ROM mechanika odpojena. Toho docílíte 

nezaškrtnutím položky Connect at power on.  



 

 

V prostředí VMware můžete připojit k virtuální mechanice fyzickou mechaniku, zaškrtnutím 

položky Use physical drive. V seznamu poté musíte vybrat, která mechanika se má 

připojit. Jestliže máte nějaké problémy s použitím normálního režimu, použijte nastavení 

Legacy emulation. Toto nastavení však nepodporuje např. záznam na CD, čtení 

vícesekčních CD nebo čtení či zápis na DVD.  

Namísto reálného zařízení můžete k virtuální CD-ROM mechanice připojit i obraz CD 

média, vytvořený ve formátu ISO 9660. Pokud chcete takto učinit, pak vyberte položku 

Use ISO Image a pomocí položky Browse vyhledejte adresář, ve kterém je obraz uložen. 

Poslední možností nastavení je nastavení uzlu virtuálního zařízení. Můžete zde také zvolit 

rozhraní zařízení (IDE nebo SCSI). Ovšem většina operačních systémů podporuje  

CD-ROM mechaniky s rozhraním IDE podstatně lépe než mechaniky s rozhraním SCSI. 

Floppy (Disketová mechanika) 

Protože disketa je vyjímatelné médium, můžete disketové mechaniky odpojovat a znovu 

připojovat v době chodu hostujícího operačního systému. Pokud ovšem hostitelský systém 

nemá stále připojenou disketovou mechaniku (což je typické např. pro přenosné počítače), 

pak raději spouštějte virtuální stroj bez připojené disketové mechaniky. Tedy položku 

Connect at power on nezaškrtávávejte.  

Při použití fyzické mechaniky máte možnost pouze jednoho výběru, máte-li ovšem fyzicky 

připojenou pouze jednu disketovou mechaniku.  

Kromě použití reálných mechanik hostitelského systému můžete virtuální mechaniky připojit  

i k souboru, obsahující obraz diskety. Pokud chcete takto učinit, pak vyberte položku Use 

floppy image a pomocí položky Browse vyhledejte adresář, ve kterém je obraz uložen. 

Ethernet (Síť) 

V hostujícím operačním systému můžete nastavit až tři virtuální ethernetová rozhraní.  

Zvolíte-li Bridge, znamená to, že budete vytvářet mostovou síť. Hostitelský systém se pak 

chová tak, jako by měl další síťové rozhraní, vytvořené pro hostující systém. Z toho 

vyplývá, že toto rozhraní musí být konfigurováno v hostujícím systému. Síťová adresa 

hostujícího systému se v tomto případě liší od síťové adresy hostitelského systému.  

V mnoha případech můžete adaptér nakonfigurovat jednoduše pomocí DHCP. 



 

 

Volbou Host-only můžete připojit virtuální síťový adaptér k celé virtuální síti, běžící uvnitř 

hostitelského systému.  

Poslední volbou je NAT, která slouží k vytvoření NAT sítě. Principiálně se tato síť podobá 

síti předcházející, avšak základním rozdílem je to, že u NAT sítě má hostující systém přístup 

k vnější síti. NAT síť využívá schopnosti VMware překládat síťové adresy, díky čemuž lze 

hostitelský stroj změnit v síťovou bránu. 

Chcete-li v prostředí VMware nastavit virtuální stroj s vlastním síťovým rozhraním, zvolte 

volbu Custom a následně si vyberte ze seznamu to rozhraní Vmnet, které chcete používat.  

Pokud chcete, aby se síť připojovala při startu virtuálního stroje, zvolte položku Connect at 

power on. 

Serial Port (Sériový port) 

V editoru nastavení najdete volby, potřebné pro vytvoření sériových portů COM1 a COM2. 

Součástí tohoto editoru jsou následující volby. 

Volba Connection říká, o který port hostitelského systému se jedná. Jde-li o reálný sériový 

port, zvolte Use physical serial port. V seznamu máte možnost vybrat z dostupných portů 

(např. COM1). Jestliže při nastavování výstupu zvolíte Use output file, budete moci 

přesměrovat výstup ze sériového portu do souboru, uloženého v hostitelském operačním 

systému (to znamená, že na reálny port nebudou z virtuálního systému předána žádna data). 

Jako poslední možnost můžete nastavit pojmenovanou rouru, zvolením položky Use named 

pipe. Hostitelský operační systém bude v takovém případě komunikovat se sériovým 

portem hostujícího systému přes pseudoterminál. Název roury musí být zadán formou 

\\.\pipe\název roury. Následně zvolte ze seznamu This end is the server nebo 

This end is the client. Jestliže plánujete začít konec prvním spojením, vyberte This end is 

the server. Nakonec zvolte The other end is an application nebo The other end is  

a virtual machine. 

Zaškrtnete-li volbu Connect at power on, budou sériové porty aktivovány a připojeny  

v době spuštění virtuálního stroje. Tuto volbu by jste měli použít např. tehdy, máte-li  

k nějakému sériovému portu připojenou myš.  



 

 

Parallel Port (Paralelní port) 

Součástí konfigurace virtuálního stroje mohou být až dva paralelní porty, jejichž 

konfigurace se podobá konfiguraci portů sériových.  

Najdete tady opět volbu Connection, v níž můžete zadat Use physical parallel port. Tím 

virtuálnímu stroji řeknete, že port bude připojen k reálnému portu hostitelského stroje.  

V seznamu máte poté možnost vybrat z dostupných portů (např. LPT1). U reálného portu 

můžete zvolit obousměrný režim, určený pro taková zařízení, která komunikují s operačním 

systémem (např. mechaniky Zip nebo některé novější tiskárny). Tohoto režimu docílíte 

zaškrtnutím položky Bidirectional mode. Další možnosti je Use output file, umožňující 

odesílání dat z virtuálního paralelního portu do souboru v hostitelském systému.  

V editoru nastavení tu najdete opět i volbu Connect at power on, umožňující připojení 

paralelního portu již v době startu hostujícího operačního systému. Tato volba je velmi 

důležitá, neboť některé hostující systémy nemusí být schopné správně rozpoznat zařízení, 

které nebylo detekováno v době spouštění.  

USB Controller (USB zařízení) 

VMware Workstation podporuje univerzální sériovou sběrnici (USB) na všech hostitelských 

systémech. Jakmile se nějaké USB zařízení připojí k ovladači, tvořícímu součást jádra 

operačního systému, musí jádro získat právo výhradního přístupu k tomuto zařízení.  

A protože můžete mít spuštěno několik operačních systémů, je nezbytné, abyste pochopili, 

jakým způsobem virtuální stroje získávají kontrolu na USB zařízeními. Celý mechanismus je 

poměrně jednoduchý. Má-li určitý virtuální stroj fokus (tj. řízení myši a klávesnice), pak 

úplné řízení USB zařízení přebírá ten hostující operační systém, který je spuštěn právě  

v tomto virtuálním stroji. Z toho vyplývá, že hostující a hostitelský operační systém mohou 

současně využívat různá USB zařízení, avšak nikdy nemohou současně pracovat s jedním 

USB zařízením. Pokud chcete VMware dočasně zakázat přebírání řízení nových zařízení, 

pak zrušte zaškrtnutí volby Automatically connect new USB devices to this virtual 

machine when if has fokus.  



 

 

Sound Adapter (Zvukový adapter) 

Chcete-li v hostujícím operačním systému nakonfigurovat zvukový adaptér, musíte mít  

v seznamu hardware i Sound Adapter (nebo Audio). S největší pravděpodobností budete 

mít na výběr v hostujícím systému pouze z jediného zvukového adaptéru. V části 

Connection můžete zvolit, zda půjde o výchozí hostitelské zvukové zařízení, volbou Use 

default host sound adapter nebo toto zvukové zařízení upřesnit, volbou Specify host 

sound adapter.  

Volbou Connect at power on umožníte připojení zvukového adaptéru již v době spouštění 

hostujícího systému. Pokud ji zakážete, zabráníte tak některým hostujícím systémům  

v přehrávání nejrůznějších zvuků, doprovázejících jejich start.  

Processors (Procesory) 

V editoru nastavení můžete nastavit virtuální procesor. Jediným možným nastavením je 

zvolení množství procesorů.  

Generic SCSI Device (Generic SCSI zařízení) 

Sekce Generic SCSI Device vám nabízí možnost připojení maximálně 7 disků. Toto 

zařízení zajišťuje překlad všech SCSI příkazů, posílaných či přijímaných z reálného SCSI 

zařízení, připojeného k hostitelskému stroji, na SCSI příkazy pro či z virtuálního SCSI 

zařízení, připojeného k virtuálnímu stroji. Tato možnost je vhodná zejména pro připojování 

skenerů a CD-RW mechanik k hostujícím operačním systémům. 

Volbou položky Connect at power on zařídíte, aby se toto zařízení připojilo při spuštění 

hostujícího operačního systému. V části Connection můžete upřesnit fyzické SCSI zařízení 

výběrem ze seznamu. [1][2]  

Poslední možností nastavení je nastavení uzlu virtuálního zařízení ze seznamu.  

Options 

Na této kartě najdete volby, které se nevztahují k hardwaru. 



 

 

General 

- Virtual Machine Name - do tohoto pole můžete zadat název okna, který bude 

zobrazen v hostitelském operačním systému. Toto pole nemůžete ponechat prázdné. 

- Guest Operating System - v seznamu si můžete nastavit ten hostující operační 

systém, který budete využívat. Touto volbou dojde k upravení některých 

hardwarových parametrů, aby bylo dosaženo optimálního výkonu hostujícího 

systému. Poté musíte v seznamu Version upřesnit verzi hostujícího operačního 

systému, který použijete.  

- Working directory - místo, z kterého se obnovuje režim spánku nebo snímky 

Power 

- Power options 

- Power on after opening this virtual machine – vyberete-li tuto položku, zajistíte 

tím automatický start vybraného virtuálního stroje při spuštění VMwaru 

- Enter full screen mode after powering on – vyberete-li tuto položku, vybraný 

virtuální stroj přejde do celoobrazovkového režimu ihned po spuštění 

- Close after powering off or suspending – vyberete-li tuto položku, vybraný 

virtuální stroj se automaticky zavře, jakmile stisknete tlačítka Power off nebo 

Suspend.  

- Power Controls – tady můžete měnit nastavení některých tlačítek, určených pro 

práci s virtuálním strojem  

 Toto tlačítko můžete nakonfigurovat dvěma způsoby. Jestliže chcete, aby toto 

tlačítko fungovalo jako vypínač napájení na napájecím zdroji, vyberte Power Off. 

Virtuální stroj bude okamžitě vypnut bez ohledu na probíhající činnost. Jestliže 

chcete, aby toto tlačítko vyslalo signál pro vypnutí hostujícího operačního systému, 

vyberte Shut Down Guest.  

 Tlačítko Suspend není konfigurovatelné. 

 Tlačítko Power on také není konfigurovatelné.  



 

 

 Toto tlačítko můžete nakonfigurovat dvěma způsoby. Jestliže chcete, aby tlačítko 

fungovalo jako vypínač Reset, vyberte Reset. Virtuální stroj bude okamžitě 

resetován bez ohledu na probíhající činnost. Jestliže chcete, aby tlačítko vyslalo 

signál pro restart hostujícího operačního systému, vyberte Restart Guest.  

- Run WMware Tools scripts – tímto nastavením dovolíte provozování skriptů. 

Určujete kdy dané skripty budou spuštěny a to: 

- After powering on (po zapnutí) 

- After resuming (po obnovení) 

- Before suspending (před režimem spánku) 

- Before powering off (před vypnutím) 

Shared Folders 

Toto nastavení dovoluje virtuálnímu stroji sdílet složky s hostitelskými soubory systému, 

vhodnými pro přenos souborů. Přidat položku můžete pomocí tlačítka Add (Přidat). 

Otevře se průvodce vytvořením sdílených složek. Tady stačí jen napsat název složky, 

vyhledat adresář, který chcete sdílet a nakonec zvolit, zda bude možné složky měnit, či 

nikoliv.  

Snapshots 

- General – tady můžete zakázat snímkování virtuálního stroje zaškrtnutím položky 

Disable snapshots 

- When powering off – v tomto nastavení volíte ovládání snímků v době, kdy je 

virtuální stroj vypnut. Nastavení obsahuje: 

- Just power off – vypnout bez uložení změn snímků 

- Revert to the snapshot – vrátit původní snímek virtuálního stroje 

- Take a new snapshot – vytvořit nový snímek stavu virtuálního stroje 

- Ask me – vždy se zeptat, co chci se snímkem dělat 



 

 

Guest Isolation 

Jestliže chcete přetahovat soubory z hostitelského systému do virtuálního stroje a naopak, 

pak zvolte položku Enable drag and drop to and from this virtual machine. 

Jestliže chcete kopírovat a vkládat soubory z hostitelského systému do virtuálního stroje  

a naopak, pak zvolte položku Enable copy and paste to and from the virtual machine.  

Advanced 

- Process priorities – umožňuje nastavit procesům prioritu. Více informací o tomto 

nastavení naleznete v části Priority. 

- Settings 

- Run with debugging information – umožňuje běh virtuálního stroje tak, že navíc 

sbírá informace o ladění 

- Disable acceleration – umožňuje zakázat zrychlení 

- Disable memory page trimming  

- Log virtual machine progress periodically – umožňuje pravidelně zapisovat běh 

virtuálního stroje 

- File locations – informuje o umístění konfigurace virtuálního stroje  

a o záznamových souborech [2] 

4) Vytvoření nového virtuálního stroje 

a) Spusťte VMware Workstation.  

Buď dvakrát klikněte na ikonu VMware na ploše nebo použijte Start > Programs  

> VMware > VMware Workstation. 

b) Jestliže otevíráte VMware poprvé a při instalaci jste nevložili sériové číslo, budete 

upozornění na jeho vložení.  

c) Spusťte průvodce vytvořením nového virtuálního stroje.  

Když spustíte VMware, můžete otevřít existující virtuální stroj a nebo vytvořit nový. 

Jestliže chcete vytvořit nový virtuální stroj, vyberte File > New > Virtual Machine. 



 

 

d) Průvodce vytvořením nového virtuálního stroje představuje sérii oken, které navigují 

co máte v danou chvíli zvolit.  

Pro pokračování na další okno stiskněte tlačítko Next (Další). 

e) Vyberte metodu, kterou chcete použít pro konfiguraci virtuálního stroje. 

Jestliže vyberete Typical, průvodce vám dovolí nastavit pouze následující: 

- hostující operační systém 

- jméno a místo uložení složky virtuálního stroje 

- typ síťového připojení 

- jestli chcete přidělit veškeré místo virtuálnímu disku 

- jestli chcete rozdělit virtuální disk do 2 GB složek. 

Jestliže vyberete Custom, budete moct kromě předchozích možností nastavit ještě: 

- počet procesorů 

- množství paměti 

- typ vstupně/výstupních zařízení 

- druh disku (vytvořit nový virtuální disk, použít existující virtuální disk nebo 

použít fyzický disk) 

- typ disku (IDE, SCSI) 

f) Jestliže jste vybrali jako konfiguraci Typical, skočte na krok g) 

Jestliže jste vybrali jako konfiguraci Custom, musíte nyní vybrat formát virtuálního 

stroje. Chcete-li, aby vytvořený stroj plně podporoval veškeré Workstation 5 

vlastnosti, pak zvolte New – Workstation 5. Nebo, aby byl kompatibilní s VMware 

produkty, pak zvolte Legacy.  

g) Vyberte hostující operační systém a jeho přesnou verzi. 

Poznámka: Jestliže seznam neobsahuje operační systém, který plánujete instalovat 

do VMware, zvolte Other (Jiný) jak při výběru operačního systému, tak při výběru 

verze.  



 

 

h) Vepište název a složku pro virtuální stroj. Pokud již máte pro umístění virtuálního 

stroje vytvořenou složku, můžete jí pomocí tlačítka Browse vyhledat. 

i) Jestliže jste vybrali jako konfiguraci Typical, skočte na krok k).  

Upřesněte množství procesorů, které využijete pro virtuální stroj. Nastavení Two 

podporují pouze hostitelské systémy s nejméně dvěmi logickými procesory.  

j) Nastavte množství paměti pro virtuální paměť. Jestliže si nejste jisti kolik nastavit, 

zvolte výchozí nastavení a poté klikněte na tlačítko Next (Další). 

k) Vyberte síťové připojení.  

- jestliže je hostitelský systém připojen k síti a máte zvláštní IP adresu pro 

virtuální stroj, vyberte Use bridged networking 

- jestliže nemáte zvláštní IP adresu pro virtuální stroj, ale chcete být připojeni  

k internetu, vyberte Use network address translation (NAT). NAT 

poskytuje sdílení souborů mezi virtuálním strojem a hostitelským operačním 

systémem.  

- jestliže chcete připojit hostující operační systém k soukromé virtuální síti na 

hostitelským počítači, zvolte Use host-only networking 

- jestliže nechcete, aby hostující systém byl připojen k síti, zvolte Do not use  

a network connection. 

l) Jestliže jste vybrali jako konfiguraci Typical, klikněte na tlačítko Finish 

(Dokončit).  

Jestliže jste vybrali Custom, pokračujte na následující krok. 

m) Vyberte typ SCSI adaptéru, který chcete ve virtuálním stroji použít. 

IDE a SCSI adaptéry jsou ve virtuálním stroji nainstalovány. IDE adaptér je vždy 

ATAPI. Vybrat můžete ze dvou SCSI adaptérů, BusLogic a LSI Logic.  

n) Vyberte disk, který chcete použít ve virtuálním stroji (vytvořit nový virtuální disk, 

použít existující virtuální disk nebo použít fyzický disk). 

o) Vyberte, jestli chcete vytvořit IDE nebo SCSI disk. 



 

 

p) Upřesněte kapacitu virtuálního disku. Velikost disku můžete volit od 0,1 do  

950 GB.  

Jestliže chcete přidělit veškeré místo virtuálnímu disku, zaškrtněte položku Allocate 

all disk space now. Jestliže chcete rozdělit virtuální disk do 2 GB složek, pak zvolte 

Split disk into 2 GB files. 

q) Nakonec upřesněte místo ukládání informací o virtuálním disku a vytváření nového 

virtuálního stroje ukončete stisknutím tlačítka Finish (Dokončit). 

5) Instalace hostujícího operačního systému 

Nový virtuální stroj je jako fyzický počítač s prázdným pevným diskem. Předtím než ho 

začnete používat, musíte rozdělit a zformátovat virtuální disk a nainstalovat operační 

systém. Instalační program operačních systému by měl rozdělení a formátování zajistit. 

Instalace hostujícího operačního systému VMware virtuálního stroje je v podstatě stejná 

jako instalace na fyzického počítače.  

V přílohách P II, P III a P IV naleznete návody na instalaci operačních systémů: Microsoft 

Windows XP, Slackware Linux 11.0 a MS-DOS. 

6) Smazání virtuálního stroje 

Workstation umožňuje odstranit virtuální stroj ze Seznamu oblíbených nebo jej kompletně 

smazat. 

- odstranění virtuálního stroje ze Seznamu oblíbených – klikněte pravým tlačítkem 

myší na název virtuálního stroje v Seznamu oblíbených a zvolte Remove from 

Favorites. 

- smazání virtuálního stroje - klikněte pravým tlačítkem myší na název virtuálního 

stroje v Seznamu oblíbených a zvolte Delete From Disk, nebo vyberte virtuální 

stroj, který chcete smazat a zvolte VM > Delete from disk. 

7) Přidání nového hardwaru do virtuálního stroje 

Stejně jako u reálného počítače, můžete vložit nový hardware. V tomto případě však 

nevkládáte hardware fyzicky.  



 

 

a) Zvolte VM > Settings. Na kartě Hardware klikněte na položku Add (Přidat). 

Otevře se vám průvodce přidáním nového hardwaru. V průvodci musíte zvolit 

hardware, který chcete přidat a zvolit položku Next (Další).  

b) V následujících krocích musíte zvolit konfiguraci přidávaného hardwaru. 

8) Odebrání hardwaru virtuálního stroje 

a) Na kartě Hardware, kterou najdete zvolením VM > Settings, vyberte hardware, 

který máte v úmyslu odebrat.  

b) Po vybrání hardwaru zvolte položku Remove (Odebrat). 

9) Spuštění virtuálního stroje 

a) Spusťte VMware Workstation. 

b) Vyberte virtuální stroj, který chcete spustit. Zvolte File > Open a vyhledejte obraz 

virtuálního stroje, který chcete použít. 

c) Zapněte virtuální stroj kliknutím na tlačítko Power On. 

d) Klikněte kamkoliv do okna virtuálního stroje a virtuální stroj převezme řízení 

klávesnice či myši. 

Nyní můžete s virtuálním strojem pracovat jako s počítačem reálným. 

10) Režim spánku virtuálního stroje a jeho probuzení  

Ve VMware je stejně jako u reálného počítače možné uložit aktuální stav virtuálního stroje 

pomocí režimu spánku. Později jej můžete kdykoliv obnovit a vrátit se tak zpátky ke své 

práci, přesně tam, kde jste skončili.  

Režim spánku virtuálního stroje 

a) Jestliže virtuální stroj běží v celoobrazovkovém režimu, stisknutím Ctrl+Alt se 

vrátíte zpět do okna VMware. 

b) Přepněte virtuální stroj do režimu spánku stisknutím tlačítka Suspend.  

c) Jakmile přejde virtuální stroj do režimu spánku, můžete bezpečně ukončit VMware 

Workstation (File > Exit).  



 

 

Probuzení virtuálního stroje 

a) Spusťte VMware Workstation. Zvolte File > Open a vyhledejte obraz virtuálního 

stroje, který chcete obnovit. 

b) Stiskněte tlačítko Resume. 

11) Reset virtuálního stroje 

Stejně jako u reálného počítače, můžete hostující operační systém resetnout. Jestliže 

resetnete virtuální stroj v době ukládání dat na virtuální disk, budou tyto data nenávratně 

ztracena nebo poškozena.  

Virtuální stroj resetnete kliknutím na tlačítko Reset. 

12) Vypnutí virtuálního stroje 

Stejně jako u reálného počítače, můžete vypnout hostující operační systém před vypnutím 

virtuálního stroje.  

a) Zvolte např. u hostujícího systému Microsoft Windows Start > Vypnout počítač  

> Vypnout. 

b) Po vypnutí hostujícího operačního systému můžete fyzicky vypnout virtuální počítač 

stisknutím tlačítka Power Off.  

Poté můžete bezpečně ukončit VMware Workstation. 

13) Sada nástrojů VMware Tools 

Tato sada je součástí dodávky VMware. Pro instalaci sady VMware Tools nebudete 

potřebovat příliš mnoho místa na pevném disku hostujícího systému. 

Chcete-li ze svého PC dostat optimální výkon, musí použitý operační systém podporovat 

nejen všechna zařízení, ale i všechny jejich vlastnosti. Jinými slovy řečeno, nejenom, že by 

jste chtěli využít veškerá případná hardwarová urychlení, ale současně chcete, aby tato 

urychlení byla skutečně funkční.  

Součástí sady VMware Tools jsou funkce, z nichž mnohé usnadňují komunikaci 

hostitelského a hostujícího systému. Jedná se především o tyto funkce: 



 

 

- přesouvání ukazatele myší mezi hostitelským a hostujícím systémem bez nutnosti 

použití klávesové zkratky Ctrl+Alt 

- možnost kopírování a vkládání dat mezi hostitelským a hostujícím systémem  

(či hostujícími systémy, máte-li jich spuštěno více) 

- zmenšení velikosti virtuálních disků, uložených v hostitelském systému 

- nastavení hodin hostujícího systému podle hodin systému hostitelského 

VMware Tools dále obsahuje ovládač zobrazení pro SVGA režimy VMware. Díky tomuto 

ovládači pak můžete využít větší rozlišení a barevnou hloubku. 

Chcete-li však většinu z těchto funkcí využít, musí být hostující systém spuštěn v grafickém 

režimu, nikoliv v textovém. I přesto však instalace VMware Tools pro některé operační 

systémy obsahuje nástroje, vhodné i pro textový režim.  

Součástí každé sady VMware Tools je malá aplikace, umožňující povolení některých 

speciálních vlastností v hostujícím operačním systému. Tato aplikace se ukrývá pod názvem 

VMware Tools Properties v případě hostujících systémů řady Microsoft Windows a VMware 

Toolbox v případě systému Linux a FreeBSD.  

Způsob spuštění aplikace VMware Tools Properities či VMware Toolbox závisí na 

hostujícím systému. Jakmile zapnete aplikaci, zobrazí se hlavní okno, v němž uvidíte několik 

nastavení.  

VMware Tools jsou dostupné pro následující operační systémy: 

- Microsoft Windows 

- Linux 

- FreeeBSD 

- NetWare 

Pro instalaci VMware Tools musíte provést tyto kroky: 

a) zapnout virtuální stroj, do kterého chcete instalaci provést 

b) zvolit VM > Install VMware Tools  

Zvolením této položky se automaticky, v případě hostujícího systému Microsoft 

Windows, připojí ISO obraz instalačního CD VMware Tools. V případě hostujícího 



 

 

systému Linux musíte ještě provést fyzické připojení virtuální mechaniky příkazem 

mount /dev/cdrom /mnt/cdrom. 

Poté můžete pomocí instalačního CD provést instalaci VMware Tools. Podrobnější popis 

instalace VMware Tools naleznete v manuálových stránkách produktu VMware 

Workstation. 



 

 

PŘÍLOHA P VI: NÁVOD NA POČEŠTĚNÍ A INSTALACI ČESKÉ 

MANUÁLOVÉ DOKUMENTACE SLACKWARE LINUXU 

Upozornění: Pro nastavení a instalaci musíte být přihlášeni jako root. 

Nastavení češtiny do Slackware Linuxu 

Lokalizace je nastavení systému tak, aby programy na uživatele mluvily česky, používaly 

českou mapu znaků a české fonty.  

Nastavení locale 

Locale způsobí, že programy budou používat české menu a informace z výstupu budou také  

v českém formátu. Zjištění nastavení locale se provede příkazem locale. V podstatě jde  

o nastavení knihoven libc a glibc. Ve Slackware Linuxu je standardně nastaveno na en_US. 

Zjištění nastavení locale: 

LANG=en_US 
LC_CTYPE="en_US" 
LC_NUMERIC="en_US" 
LC_TIME="en_US" 
LC_COLLATE="en_US" 
LC_MONETARY="en_US" 
LC_MESSAGES="en_US" 
LC_PAPER="en_US" 
LC_NAME="en_US" 
LC_ADDRESS="en_US" 
LC_TELEPHONE="en_US" 
LC_MEASUREMENT="en_US" 
LC_IDENTIFICATION="en_US" 
LC_ALL=en_US  

Jaké nastavení locale může systém použít, zjistíte příkazem locale -a. Mimo jiné na 

výstupu dostanete i tyto možnosti. 

cs_CZ 
cs_CZ.utf8  

Ve Slackware Linuxu se nastavení locale ukládá do souborů 

/etc/profile.d/lang.sh a /etc/profile.d/lang.csh. To se používá jen 



 

 

jako globální nastavení. Pokud chcete toto nastavení mít lokálně, musíte nastavení locale na 

cs_CZ provést zápisem do souboru ~/.profile pomocí následujících příkazů: 

export LANG=cs_CZ 
export LC_ALL=cs_CZ  

Nastavení konzole 

Jestliže máte locale nastavené na cs_CZ a pracujete v konzoli, je třeba používat i českou  

mapu znaků a české fonty. To provedete příkazy loadkeys a setfont. Mapy 

klávesnice jsou uloženy v /usr/share/kbd/keymaps/i386/qwerty/. Mimo jiné 

zde naleznete i české mapy: 

cz-cp1250.map.gz 
cz-lat2.map.gz 
cz-lat2-prog.map.gz 
cz.map.gz  

Fonty jsou uloženy v /usr/share/kbd/consolefonts/. Mimo jiné zde naleznete 

tyto fonty: 

cp1250.psfu.gz  
lat2-08.psfu.gz 
lat2-10.psfu.gz 
lat2-12.psfu.gz 
lat2-14.psfu.gz 
lat2-16.psfu.gz  
lat2a-16.psfu.gz 

Ve Slackware Linuxu je nastavení mapy a fontu konzole uloženo v souborech 

/etc/rc.d/rc.font a /etc/rc.d/rc.keymap. Opět je to globální nastavení 

systému, a aby bylo lokální, musíte zapsat do souboru ~/.profile následující příkazy: 

loadkeys cz-lat2.map.gz 
setfont lat2-16.psfu.gz 

České manuálové stránky 

České manuálové stránky jsou distribuovány jako zdrojové texty pro groff  (program pro 

zobrazení těchto stránek) ve formátu *.tar.gz vhodném pro distribuce Slackware Linux. 



 

 

Pro stažení manuálových stránek můžete použít tento odkaz:  

ftp://ftp.win.tue.nl/pub/linux-local/manpages/translations/ 

Pro vložení manuálových stránek můžete využit vytvoření ISO obrazu ze staženého souboru 

pomocí např. programu Nero Burning ROM. Připojení ISO obrazu do virtuální stanice 

proveďte následujícím způsobem: 

- otevřete si nastavení virtuálního stroje (VM > Settings) a vyberte tu mechaniku, 

kterou chcete použít 

- vyberte použít ISO obraz (Use ISO Image) a následně pomocí položky Browser 

(Procházet) vyhledejte adresář, ve kterém je uložen obraz souboru 

- klikněte na OK, uložte konfiguraci a zavřete nastavení virtuálního stroje 

Instalace stránek ze souboru 

Nyní musíte připojit mechaniku do Linuxu pomocí příkazu mount /dev/cdrom /mnt 
/cdrom. Poté je nutné načtený soubor rozbalit. Pokud se nacházíte v adresáři, do kterého 

chcete soubor rozbalit, stačí použít příkaz tar xfz man-pages-cz-x.xx.tgz  

v jiném případě musíte uvést za příkazem adresář, do kterého jej chcete rozbalit. Např. tar 
xfz man-pages-cz-x.xx.tgz /stranky. 

Samotná instalace stránek je velmi jednoduchá. Po rozbalení balíku jednoduše, v příslušném 

adresáři, provedete příkaz make install, který zajistí nainstalování manuálových 

stránek do adresáře /usr/local/man/cs. 

Nakonec stačí jen restartovat virtuální stroj. 

ftp://ftp.win.tue.nl/pub/linux-local/manpages/translations/


 

 

PŘÍLOHA P VII: TESTOVACÍ PŘÍKLADY 

cd /home/student 
ls –l home 
mkdir texty 
touch newfile 
cat /etc/ passwd 
rm newfile 
cp /etc/ passwd uzivatele 
mv stary novy 
head -5 zprava 
sort zkouska 
chod 640 textik 
chown student textik 
sleep 10 & 
cat kniha skripta > obsah 2> chyby 
tar czf gm.tar.gz gm 
tar xzf gm.tar.gz 
45 2 * * *  rm /home/neco 
Useradd –m –s /bin/bash –c “student” student 
fdisk /dev/hda 
mount /dev/cdrom /mnt/cdrom 

skripty 

Tento skript nejprve vypíše, příkazem echo, na obrazovku „Mazaní souboru“, dále zajistí 

smazání všech dočasných souboru, které se nachází v adresáři /tmp a nakonec opět vypíše 

na obrazovku „Smazáno!!!“. 

echo Mazani souboru.... 
rm /tmp/* 
echo Smazano!!! 

První příkaz skriptu date zobrazí aktuální datum. Samotný příkaz echo zobrazí prázdný 

řádek. Třetí příkaz skriptu použije substituci příkazu k nastavení pozičních parametrů jako 

výstup z programu date. Poslední příkaz zobrazuje vybrané argumenty.  

date  
echo 
set $(date) 
echo $3 $2 $6 



 

 

Tento skript otestuje existenci souboru /etc/passwd. Jestliže existuje pak se na 

obrazovku vypíše „soubor existuje“, jestliže neexistuje vypíše „soubor neexistuje!!!“. 

if test -e /etc/passwd 
then 
echo soubor existuje 
else 
echo soubor neexistuje!!! 
fi 
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